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Preface 
The Agile PLM documentation set includes Adobe® Acrobat PDF files. The Oracle Technology 

Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html contains the 
latest versions of the Agile PLM PDF files. You can view or download these manuals from the Web 
site, or you can ask your Agile administrator if there is an Agile PLM Documentation folder available 
on your network from which you can access the Agile PLM documentation (PDF) files. 

Note To read the PDF files, you must use the free Adobe Acrobat Reader version 7.0 or later. 
This program can be downloaded from the Adobe Web site http://www.adobe.com. 

The Oracle Technology Network (OTN) Web site 
http://www.oracle.com/technology/documentation/agile.html can be accessed through Help > 
Manuals in both Agile Web Client and Agile Java Client. If you need additional assistance or 
information, please contact support http://www.oracle.com/agile/support.html 
(http://www.oracle.com/agile/support.html) for assistance. 

Note Before calling Oracle Support about a problem with an Agile PLM manual, please have 
the full part number, which is located on the title page. 

TTY Access to Oracle Support Services 

Oracle provides dedicated Text Telephone (TTY) access to Oracle Support Services within the 
United States of America 24 hours a day, 7 days a week. For TTY support, call 800.446.2398. 
Outside the United States, call +1.407.458.2479. 

Readme 

Any last-minute information about Agile PLM can be found in the Readme file on the Oracle 

Technology Network (OTN) Web site http://www.oracle.com/technology/documentation/agile.html 

Agile Training Aids 

Go to the Oracle University Web page 
http://www.oracle.com/education/chooser/selectcountry_new.html for more information on Agile 
Training offerings. 

Accessibility of Code Examples in Documentation  

Screen readers may not always correctly read the code examples in this document. The 
conventions for writing code require that closing braces should appear on an otherwise empty line; 
however, some screen readers may not always read a line of text that consists solely of a bracket or 
brace.  

Accessibility of Links to External Web Sites in Documentation  

This documentation may contain links to Web sites of other companies or organizations that Oracle 
does not own or control. Oracle neither evaluates nor makes any representations regarding the 
accessibility of these Web sites.  

http://www.oracle.com/technology/documentation/agile.html
http://www.adobe.com/
http://www.oracle.com/technology/documentation/agile.html
http://www.oracle.com/agile/support.html
http://www.oracle.com/agile/support.html
http://www.oracle.com/technology/documentation/agile.html
http://www.oracle.com/education/chooser/selectcountry_new.html
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Chapter 1 

Installation Checklists 

This chapter includes the following: 

 Pre-Installation Checklist ..................................................................................................................................... 1 
 Application Server Installation Checklist .............................................................................................................. 2 
 Clustered Application Server Installation Checklist ............................................................................................. 2 
 File Manager Installation Checklist ...................................................................................................................... 3 
 Web Proxy Server Installation Checklist .............................................................................................................. 4 

 
 

Pre-Installation Checklist 

Note If you are installing on Windows, you must have local Administrator privileges. 

Before installing the Agile PLM software, you need to log in to your machine and check the 
following: 

 Can you ping all servers, including the database server, on which you plan to install Agile PLM 
components? For example, try pinging the database server from the application server. 

 Have you verified the Domain Name System (DNS) host name of each server on which you plan to install 
Agile PLM components? In DNS, the fully qualified domain name consists of the hostname, then a period, 
then the domain name. 

Note When you are prompted by the Agile PLM installer to enter a host name, enter the fully 
qualified domain name of the server. 

 Is your Agile PLM database server installed and running? 

 Is Oracle Application Server 10g (10.1.3.1.0) installed? 

Note Installation of Oracle Application Server 10g from the Agile PLM installer is only available 
on Windows. 

 Have you verified that you have read, write, and execute permissions for the computer on which you want 
to install Agile PLM? 

Additionally, if you are upgrading: 

 Have you backed up the files on your File Manager server? 

 Have you uninstalled the previous version of Agile PLM? 

 

Note You must be able to complete this checklist before installing Agile PLM. 
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Application Server Installation Checklist 

Follow these steps to install the Agile Application Server: 

  Install Oracle Application Server 10g (10.1.3.1.0) J2EE Server and Web Server. 

See “Installing Oracle Application Server”. 

  Stop the Oracle Application Server. 

See “Stopping Oracle Application Server”. 

  Install the Agile PLM Application Server component. 

See “Installing Agile PLM.” 

Note The Agile PLM installer may prompt for you to stop Oracle Application Server even though 
it is already stopped. If so, Click OK to continue. 

  On Windows: Restart the machine. 

  Configure JMS resources and deploy the Agile application on Oracle Application Server. 

See “Deploying the Agile Application”. 

  Verify that the Agile Application Server is working properly. 

See “Verifying Your Agile Application Server on page 21”. 

  (Optional) Configure a Web proxy server for your Agile PLM system. 

To install the Oracle Application Server plug-in and other files needed to use Microsoft Internet Information Services (IIS) as 
your Web proxy server, install the Agile PLM Web Proxies component on your Web server.  See  “Installing Agile PLM.” 

To configure your Web proxy server, see “Configuring a Web Proxy Server for Agile PLM.” 

 
 

Clustered Application Server Installation 
Checklist 

Follow these steps to install an Agile Application Server cluster: 

  Install Oracle Application Server 10g (10.1.3.1.0) J2EE Server and Web Server on each server. 

Important Make sure all servers in the cluster use the same operating system. 

See About Agile Application Server Clusters and “Installing Oracle Application Server”. 

 Install Agile PLM  on the primary server. Make sure you choose Advanced Mode during installation. 

See  ”Installing Agile PLM on the Primary Server on page 28." 

 Install Agile PLM on the secondary server. Make sure you choose Advanced Mode during installation. 
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See "Installing Agile PLM on the Secondary Server on page 28." 

  Start and configure the servers. 

See "Starting and Configuring the Primary and Secondary Servers on page 29." 

  Deploy the Agile application in the cluster. 

See “Deploying the Agile Application in a Cluster." 

  Configure a Web proxy server or a load balancer for your Agile PLM system. 

For information about configuring a Web proxy server, see Configuring a Web Proxy Server for Agile PLM on page 
43. 

For information about configuring a load balancer, see “Configuring the Load Balancer”. 

  On Solaris or Linux or AIX: Configure the JNLP MIME type. 

See “Configuring the JNLP MIME Type on U on page 32NIX”. 

 Configure the Java Client. 

See “Configuring the Java Client Settings." 

  Verify that the Agile cluster is working properly. 

See “Testing the Agile Cluster on page 32”. 

 
 

File Manager Installation Checklist 

Follow these steps to install the File Manager: 

  If you are upgrading to Agile PLM 9.2.2.4 from a release prior to Agile 9, back up and reorganize your file vault. 

See “Upgrading the File Vault”. 

  Install the Agile PLM File Manager component. 

See  “Installing Agile PLM.” 

  Start the Agile Application Server. 

  (Optional) Configure a Proxy Server for the File Manager. 

See  “Configuring a Web Proxy Server for Agile PLM.” 

  Configure the File Manager. 

See “Configuring the File Manager on page 33”. 

  Start the File Manager. 

See “Starting the File Manager on page 41”. 

  Verify that the File Manager is working properly. 

See “Validating the File Manager Installation on page 41”. 
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Web Proxy Server Installation Checklist 

Follow these steps to configure a Web proxy server in your company’s DMZ for the Agile 
Application Server and Agile File Manager: 

  Stop your Web server. 

  Install the Agile PLM Web Proxies component. 

See  “Installing Agile PLM.” 

  Configure your Web server to be a proxy server for either the Agile Application Server, the Agile File Manager, or both. 

See  “Configuring a Web Proxy Server for Agile PLM.” 

  Test the connection by logging into the Agile Web Client. 

See “Logging In to the Agile Web Client”. 
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Chapter 2 

Upgrading to Agile PLM 9.2.2.4 

This chapter includes the following: 

 Overview .............................................................................................................................................................. 5 
 Disabling Windows Services ................................................................................................................................ 6 
 Backing Up the Windows Registry ....................................................................................................................... 6 
 Upgrading the Database ...................................................................................................................................... 7 
 Upgrading the Agile PLM 9.2.2.4 Application ...................................................................................................... 7 
 Upgrading the File Vault ...................................................................................................................................... 7 
 Upgrading the Agile PLM ActiveX Control ........................................................................................................... 8 
 Upgrading Roles and Privilege Masks ................................................................................................................. 8 

 
 

Overview 

Agile PLM 9.2.2.4 is a full install that can be distributed over a wide-area network with multiple 
servers, or it can be limited to a single server with several client computers. 

Important Before upgrading to Agile PLM 9.2.2.4, read through this entire chapter and the 
Readme for the latest information. For information about optional upgrade services 
available from Agile, contact Agile Technical Support.       

Note All folder names and paths show the default settings provided during installation. 
Your system structure may be different if folder names or paths were changed 
during the Agile PLM 9.2.2.4 installation. 

 

Upgrading Agile Server Components 

Before you upgrade any components, you should make sure that all components in the Agile 
system work and communicate properly. Performing an upgrade on a system that is not functioning 
correctly will compound troubleshooting techniques. 

Important Refer to the Agile PLM Database Upgrade Guide for schema upgrade requirements. 

 

System Requirements for Upgrading 

Additional hard disk space may be required to efficiently upgrade to Agile PLM 9.2.2.4. Before you 
can install Agile PLM server components, you must have at least 60 MB of available disk space 
available where the OS is installed. It is also recommended that you have at least 100 MB of 
available disk space for the upgrade. 



Installing Agile PLM for OAS   

 

 

6 Agile Product Lifecycle Management 

  

Checking Available Disk Space and Tablespace Size 

Be sure you have enough unused disk space available on the computer where the database is 
installed before upgrading—at least 100 MB plus an amount equal to 100 percent of your current 
database and at least twice the size of your user-data tablespace.       

Important Refer to the Agile Database Installation Guide for tablespace requirements. 

 

Backing Up Files 

Note Agile PLM 9.2.2.4 is a full install and installs into a new default location. If you 
accept this location, earlier Agile releases will not be overwritten. 

Back up any existing ChangeCAST and other Agile-related folders to a safe location before 
upgrading any component to Agile PLM 9.2.2.4. 

Disabling Windows Services 

Before upgrading Agile on Windows servers, disable any Agile services. 

To disable Agile services: 

1.  Ensure that all Agile services are stopped:     

a.  Choose Start > Settings > Control Panel. 

b.  double-click the Administrative Tools icon and then double-click the Services icon. 

c.  For each Agile service in the Services dialog box, select the service, right-click and 
choose Stop in the shortcut menu. Also for each service, open the Properties dialog box 
and change the Startup Type to Disabled. 

d.  You must also stop the IIS Admin service if it is running. 

e.  Close the Services dialog box. 

2.  Restart all Windows servers in the Agile PLM system. 
 

Backing Up the Windows Registry 

If you are upgrading Agile on Windows servers, the registry contains information created by the 
Agile installation program. You can backup registry branches so that you can return your system to 
its previous state. 

Note If you have disk space available, you can backup the entire registry (instead of 
specific branches) before upgrading to Agile PLM 9.2.2.4. 

To use regedit to backup registry branches: 

1.  Choose Start > Run. 

2.  Type regedit in the Open field of the Run dialog box. 

The Registry window opens. 
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3.  Expand the HKEY_LOCAL_MACHINE > Software tree and select the Agile registry branch. 

4.  Choose Registry > Export Registry File. 

The Export Registry File dialog box appears. 

5.  Make sure the Agile branch appears in the Select Branch field. 

6.  Name the branch agilebranch, and save it to a secure location. 

7.  Select the Oracle registry branch and save it as oraclebranch to a secure location. 

In the event you do not want to continue using this release of Agile PLM 9.2.2.4, you can import 
these registry branches, and then restart the computer. 

Upgrading the Database 

The Agile database must be upgraded before deploying the Agile Application Server. Refer to the 
Agile PLM Database Upgrade Guide for details about upgrading the Agile PLM 9.2.2.4 database 

Upgrading the Agile PLM 9.2.2.4 Application 

You should uninstall the previous version of Agile PLM before installing Agile PLM 9.2.2.4 which is 
a full install. 

Important Do not install into the same folder used by the previous installation of Agile. Choose a 
new installation location. 

 

Upgrading the File Vault 

If you are upgrading to Agile PLM 9.2.2.4 from a version prior to 9.2, the file vault structure must be 
reorganized. In previous versions of Agile, files were stored in the <iFS Root> or files directory. In 
the new design, files are stored in separate directories based on a file ID. All existing files must be 
reorganized to conform to the new design specifications. If you have an existing iFS or Distributed 
File Manager (DFM) configuration, you must reorganize the files on each file server. 

To reorganize existing files: 

1.  Back up any existing Agile file vaults to a safe location before upgrading any component to 
Agile PLM 9.2.2.4. The default location for Agile iFS Files in Agile 8.5 is \\Program Files\Agile 
Product Collaboration\iFS\Files. 

If you have an existing Distributed File Managers, you must also back up the files on all the 
DFMs. 

2.  After you have copied all files into a backup directory, install the new File Manager by following 
the instructions in ―Starting the Agile PLM Installer‖ if it is not already installed. 

3.  Copy any files that you backed up earlier into the File Manager Storage Location you specified 
during the file manager installation. 

4.  Go to the AGILE_HOME\agileDomain\tools\ directory. 

file:\\Program
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5.  Run the iFSReorgV2 utility: 

Usage: java -jar iFSReorgV2.jar -basedir <value> -oldFilePrefix <value>  
[-newFilePrefix <value>] [-logging <true/false>] 

where 

 basedir is the file vault location to be reorganized 

 oldFilePrefix is the old file name prefix for the existing files in the vault 

 newFilePrefix is the new file name prefix. All of the existing files will be renamed with this 
prefix. This is an optional argument. If it is not specified, the old file name prefix is used. 

 logging enables logging of warnings or errors if set to true. The log is saved to a file named 
ifsReorg.log. 

6.  After the program completes, the reorganization summary information displays. 

7.  Go to ―Configuring the File Manager” on page 33 to configure the new file manager with the 
upgraded vault information and to validate the installation was successful. 

 

Upgrading the Agile PLM ActiveX Control 

If you used the Microsoft Excel-based client to open Agile PLM 9.2 Declarations in Microsoft Excel, 
you have the Agile PLM ActiveX Control (version 1.0.313.1) installed on your client computer. Agile 
PLM 9.2.2.4 uses a later version (1.0313.8) of the Agile PLM ActiveX Control. 

Optionally, you can uninstall the older Agile PLM ActiveX Control. If the Agile PLM preference Allow 
Downloading of Productivity Components is set to Yes, the next time you use the Agile Web Client to 
open a Declaration in Microsoft Excel, the latest version of the Agile PLM ActiveX Control will be 
downloaded and installed automatically. 

Note Before uninstalling the Agile PLM ActiveX Control, close Microsoft Excel. 

 

Upgrading Roles and Privilege Masks 

When you upgrade your Agile PLM database, any existing Agile PLM roles and privilege masks that 
your company uses are not automatically updated to include new privileges and attributes. The 
Agile PLM administrator must update existing roles and privilege masks manually using the Agile 
Java Client. 

Agile PLM includes a number of example roles that you can use to modify your own roles. They are 
stored under the Examples node folder in Java Client. Example roles are read-only and cannot be 
modified. However, you can use Save As to make a copy of an example role and modify the copy. 

Example roles include example privilege masks. When you use Save As to create a copy of an 
example role, the system populates the new role with the privilege masks. 

For more information on how to edit roles and privilege masks, see the Agile PLM Administrator 
Guide. 
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Chapter 3 

Installing Agile PLM 

This chapter includes the following: 

 Installation Process .............................................................................................................................................. 9 
 Agile PLM System Requirements ........................................................................................................................ 10 
 Obtaining Software from Oracle MetaLink ........................................................................................................... 11 
 Copying the Agile PLM Files ................................................................................................................................ 11 
 Starting the Agile PLM Installer ........................................................................................................................... 12 
 Agile PLM Components ....................................................................................................................................... 13 
 Agile PLM Installation Modes .............................................................................................................................. 14 
 Agile PLM Installation Folders ............................................................................................................................. 14 
 Agile PLM Windows Services .............................................................................................................................. 15 

 
 

Installation Process 

The installation of Agile PLM 9.2.2.4 is a full install. Agile PLM is designed to run optimally on 
multiple computers. This guide is presented with separate chapters for certain Agile PLM 
components. To set up an Agile PLM system, you should install the components in the following 
order: 
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Note If you are installing the Application Server, File Manager, and Web Proxies on the same 
machine, they can be installed at the same time. 

 

 

 

Important If you are upgrading from a previous version of Agile PLM, first read "Upgrading to 

Agile PLM 9.2.2.4 on page 5". 

 

Agile PLM System Requirements 

Agile PLM may be deployed in different configurations. The amount of time required to complete an 
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installation depends on the complexity of your Agile PLM implementation.       

Note If you are installing on Windows, make sure you have installed all Windows updates, 
especially for the DirectX component. 

For installations using a certified localized language, all server components must be installed on 
computers running the same localized OS. Clients can be running on the same localized OS or 
English OS. For detailed information about using Agile PLM with international operating systems, 
contact the Agile Support Web site. 

The general recommended configuration for Agile PLM components is one computer for each of the 
following server components: 

 Agile database 

 Agile Application Server 

It is acceptable to install multiple server components on the same computer if the additional 
resources are not available. However, the minimum hardware requirements must be increased 
based on the number of server components installed on a single computer. For specific hardware 
and software requirements, see the Capacity Planning and Deployment Guide. 

Network service and TCP/IP protocol must be enabled before you install Agile PLM. 

On Windows, if you receive the error message ―Failed to retrieve domain name from registry. 
Please enter the domain name in the TCP/IP properties and try again later‖ and the installation 
aborts, then you must setup Network service, as follows: 

1.  From the Control Panel window, double-click the Network and Dial-up icon.   

2.  right-click on the Local Area Connection icon and choose Enable from the shortcut menu. 
 

Obtaining Software from Oracle MetaLink 

Oracle minor release products are distributed as a Patchset/Minipack. A Patchset/Minipack is an 
electronic version of the software. To download the Product Patchset/Minipack, go to the Oracle 
MetaLink Web site (https:// mlrepau.us.oracle.com/) and search for the product. Refer to the 
Patchset/Minipack description and view the Readme. After you review the Readme, download the 
Product Patchset/Minipack. 

There will be one zip file which contains all Product binaries, documentation, and database files. 
Follow the installation instructions from the Install Guide to install the product. 

All Oracle MetaLink Web site files have been archived using Info-ZIP's highly portable Zip utility. 
After downloading one or more of the archives, you will need the UnZip utility or a WinZip utility to 
extract the files. You must unzip the archive on the platform for which it was intended. Verify that 
the file size of your downloaded file matches the file size displayed on MetaLink. Unzip each Zip file 
to its own temporary directory. 

Copying the Agile PLM Files 

Before installing Agile PLM, the contents of the media packs should be copied to a local directory 
with the same file structure used by the Installer. The Platforms directory must be copied into the 
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same directory as the setup file. 

Note Be sure to check the size of the media packs after copying the files to verify that all 
files have been copied. 

 

Starting the Agile PLM Installer 

Important Install and test this release on a designated test server before installing it on your 
production environment. Your test environment should mirror your production 
environment as closely as possible to provide accurate testing results. It is important 
to validate the installation of this release and confirm your integrations are working 
correctly as part of your minimum due diligence. Any problems or questions noted 
during your system testing should be resolved before installing this release on your 
production environment. 

The Agile PLM installer is a Java program. The installation of all components follows the same initial 
process up through the panel where you select the components to install. 

Before running the installer, make sure 

 On UNIX: You are not logged in as the root user. You should be logged in as the same user 
used to install the application server software. 

 You have read and completed the pre-installation checklist. You should also read and follow 
the installation checklist for each Agile PLM component you plan to install. See ―Installation 
Checklists.‖ 

 You have enough available disk space. 

Windows: at least 500MB of available disk space 

UNIX: at least 1700MB of available disk space on the drive where your default Temp directory is 
located. 

 You have disabled virus protection. 

If virus protection is enabled, components used in the installer can be falsely identified as being 
infected and lock up the installation. You can enable virus protection after the installation is 
complete. 

To start the Agile PLM installer on Windows: 

 Log in to the computer using a login with local Administrator permissions. 

1.  In the Disk1\Windows directory, double-click the setup_win.exe file. 

Note If there is insufficient Temp disk space available to complete the installation, you will 
be prompted for another location. Click Choose, select another drive, Click OK, and 
the installer will start. 

After a few moments, the Welcome screen appears. 

2.  For information about any screen in the installer, click Help. 
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To start the Agile PLM installer on UNIX: 

1.  Log into the system. 

Note If you are installing the Agile Application Server, make sure you log in as the same 
user that installed Oracle Application Server. 

2.  Open a terminal window. 

3.  Go to the directory where you copied the Agile PLM files. Locate the setup_<OS>.bin file, and 
run the program by typing the following: 

AIX: ./setup_aix.bin 
Linux: ./setup_lin.bin 
Solaris (SPARC): ./setup_sol.bin 
Solaris(X86): ./setup_solx86.bin 

 

After a few moments, the Welcome screen appears. 

4.  For information about any screen in the installer, click Help. 
 

Installer Online Help 

Each installation panel has online help. At any time during installation, you can click Help for more 
information about the panel’s options. 

Note If you leave the online help window open, it will be updated when you proceed 
through the installer panels. Otherwise, click Close at the bottom of the help window. 

 

Installer Buttons 

Agile Product Interchange installation panels have the following buttons: 

 Cancel  — Exits from the installation program. 

 Help — Displays online help. 

 Previous — Returns to the previous step. 

 Next  — Proceeds to the next step. 

 Install  — Starts installing. The Install button appears only on the Pre-Installation Summary 
panel, after you have specified installation options. 

 Done  — Exits from the installation program. On Windows, after installing certain components 
you can choose whether to restart the computer when you click Done. The Done button appears 
only on the Install Complete panel, after you have finished installing. 

 

Agile PLM Components 

During Agile PLM installation, you must select components to install. Choose from the following 
components. 
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Component Platform Installation/Configuration Documentation 

Application Server Windows/Solaris/Linux/AIX Chapter 4, “Configuring the Agile Application Server” and 
Chapter 5, “Configuring Application Server Clusters” 

File Manager Windows/Solaris/Linux/AIX Chapter 6, “Configuring the File Manager” 

Web Proxies Windows/Solaris/Linux/AIX Chapter 7, “Configuring a Web Proxy Server for Agile PLM” 

ChangeCAST Client 
(Upgrade only) 

Windows See online help for the Agile PLM installer. 

Portlet Services Windows/Solaris/Linux/AIX See the separate Agile Portlet Services Installation and 
Configuration Guide. 

API Windows/Solaris/Linux/AIX See online help for the Agile PLM installer. 

 
 

Agile PLM Installation Modes 

When installing Agile PLM, you can install in Basic or Advanced mode. Basic mode should be 
selected to install a standalone system on Oracle Application Server with the following system 
defaults: 

 Agile Application Server Virtual Path (default:Agile) 

 File Manager User Authentication (default:ifsuser/agile) 

 File Manager Virtual Path (default:Filemgr) 

If you prefer to use values different from these defaults, then select Advanced mode. In Advanced 
mode, you can install a standalone or cluster system on Oracle Application Server or BEA 
WebLogic and change the defaults above, if desired. 

Agile PLM Installation Folders 

After you install Agile PLM, the following folders appear in the AGILE_HOME folder. 

Note This list includes the folders for all Agile PLM components, although it is not 
necessary that you install them all on one computer. 

 

Folder Description 

agileDomain Agile Application Server 

AgileProxies Web proxy configuration files 

changecast ChangeCAST client 

install Installation and configuration scripts 

integration Agile Integration Framework (AIF) products such as Agile Integration Services (AIS) and Agile SDK 
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Folder Description 

jdk Java Development Kit 1.5.0_06 

Portlet_51 Agile Portlet Services for WebSphere Portal 5.1.0.2 

Tomcat Tomcat 5.0.30 

Uninstaller Agile PLM uninstaller 

 
 

Agile PLM Windows Services 

After you install Agile PLM on Oracle Application Server for Windows, the following Windows 
services are added to your system: 

Service Description 

Agile ChangeCAST Agile ChangeCAST service 

Apache Tomcat Apache Tomcat service. Start this service to start Agile File Manager. 

Oracle<instance_name>ProcessManager Oracle Process Manager service. Start this service to start all Oracle Application 
Server managed processes, including the Agile Application Server. 
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Chapter 4 

Configuring the Agile Application Server 

This chapter includes the following: 

 Overview .............................................................................................................................................................. 17 
 Installing Oracle Application Server ..................................................................................................................... 17 
 Configuring JMS Resources and Deploying the Agile Application ...................................................................... 20 
 Verifying Your Agile Application Server ............................................................................................................... 21 

 

Important When you install and configure the Agile Application Server, follow the sequence 
recommended in the ―Application Server Installation Checklist‖. 

 
 

Overview 

The Agile Application Server is the center of the Agile system, the base for the PLM platform, where 
all common services and business logic reside for the entire solution. The installation of the Agile 
Application Server includes the Agile Content Service. 

The Agile Application Server runs on Oracle Application Server 10g or BEA WebLogic Server. All 
client servers and web client users connect to the Application Server either directly or indirectly 
through a Web proxy server. 

Note If you are configuring an application server cluster, go to ―Configuring Application 
Server Clusters‖ for configuration instructions. 

 

Installing Oracle Application Server 

This section provides basic steps for installing Oracle Application Server 10g Release 3 (10.1.3.1.0) 
SOA Suite. Please see the complete Oracle Application Server installation documentation from 
Oracle before installing the server. 

For an Oracle Application Server cluster, make sure you install Oracle Application Server into the 
same directory structure on each server in the cluster. Also, all servers in the cluster must use the 
same operating system. Otherwise, you will be unable to deploy the Agile application to all servers 
in the cluster. 

Note If you are installing Agile PLM on Windows, Oracle Application Server can be installed 
with the Agile PLM installer. Make sure you have downloaded the Oracle Application 
Server files to the same machine where the Agile PLM installer is located before starting 
the installation. 
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Installing a Loopback Adapter 

If you are installing Oracle Application Server 10.1.3.1.0 on Windows, a loopback adapter is 
required in any of these scenarios: 

 you are installing on a DHCP computer 

 you are installing on a non-networked computer and plan to connect the computer to a network 
after installation 

 you are installing on a network computer (with static IP or DHCP), but you want to be able to 
run Oracle Application Server after you take the computer off the network. 

Note If you use a loopback adapter to install the application server, you may not be able to 
connect to your application server with the Java Client from another machine. 

 

Checking If a Loopback Adapter is Installed on Your Computer 

To check if a loopback adapter is installed on your computer, run the "ipconfig /all" command:  

prompt> ipconfig /all 

If there is a loopback adapter installed, you would see a section that lists the values for the 
loopback adapter. For example:  

Ethernet adapter Local Area Connection 2: 

  Connection-specific DNS Suffix  . : 
  Description . . . . . . . . . . . : Microsoft Loopback Adapter 

  Physical Address. . . . . . . . . : 02-00-4C-4F-4F-50 
  DHCP Enabled. . . . . . . . . . . : Yes 
  Autoconfiguration Enabled . . . . : Yes 
  Autoconfiguration IP Address. . . : 169.254.25.129 
  Subnet Mask . . . . . . . . . . . : 255.255.0.0 

 
 

Installing a Loopback Adapter on Windows 2003 

To install a loopback adapter on Windows 2003 or Windows XP:  

1. Open the Windows Control Panel.  

2. Double-click Add Hardware to start the Add Hardware wizard.  

3. In the Welcome window, click Next.  

4. In the Is the hardware connected? window, select Yes, I have already connected the hardware, and 
click Next.  

5. In the The following hardware is already installed on your computer window, in the list of 
installed hardware, select Add a new hardware device, and click Next.  

6. In the The wizard can help you install other hardware window, select Install the hardware that I 
manually select from a list, and click Next.  

7. In the From the list of hardware types, select the type of hardware you are installing window, 
select Network adapters, and click Next.  
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8. In the Select Network Adapter window, make the following selections:  

 Manufacturer: select Microsoft.  

 Network Adapter: select Microsoft Loopback Adapter.  

9. Click Next.  

10. In the The wizard is ready to install your hardware window, click Next.  

11. In the Completing the Add Hardware Wizard window, click Finish.  

12. Restart your computer.  

13. Right-click My Network Places on the desktop and choose Properties to display the Network 
Connections Control Panel.  

14. Right-click the connection that was just created. This is usually named "Local Area Connection 
2". Choose Properties.  

15. On the General tab, select Internet Protocol (TCP/IP), and click Properties.  

16. In the Properties dialog box, click Use the following IP address and do the following:  

a. IP Address: Enter a non-routable IP for the loopback adapter. Oracle recommends the 
following non-routable addresses:  

192.168.x.x (x is any value between 1 and 255)  

10.10.10.10  

b. Subnet mask: Enter 255.255.255.0.  

c. Record the values you entered, which you will need later in this procedure.  

d. Leave all other fields empty.  

e. Click OK.  

17. Click OK in the Local Area Connection 2 Properties dialog.  

18. Close Network Connections.  

19. Restart the computer.  

20. Add a line to the C:\winnt\system32\drivers\etc\hosts file with the following format, right after 
the localhost line:  

IP_address   hostname.domainname   hostname 

where:  

 IP_address is the non-routable IP address you entered in step 16.  

 hostname is the name of the computer.  

 domainname is the name of the domain.  

For example:  

10.10.10.10   mycomputer.mydomain.com   mycomputer 

Starting the Oracle Application Server Installation 

To install Oracle Application Server 10g Release 3 (10.1.3.1.0) on Windows: 

 Log in to the computer as a user who is a member of the Administrators group. 

1. Copy the Oracle Application Server files to your system. 
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2. Double-click the setup.exe file in the location where you copied the installer files. 

This launches Oracle Universal Installer. 

To install Oracle Application Server 10g Release 3 (10.1.3.1.0) on UNIX: 

1.  Log in as the user who will own and administer the Agile deployment (for example, the UNIX 
user ―agile‖). 

2.  Copy the Oracle Application Server files to your hard drive. 

3.  Start the installer: 

$ <installer_path>/Disk1/runInstaller 

This launches Oracle Universal Installer. 

Choosing Oracle Application Server Components to Install 

When you install Oracle Application Server as a standalone server, choose the Advanced install 
option and the following components: 

 J2EE Server and Web Server 

Choose Automatic port configuration, then specify the AS Instance Name, Administrator Username and 
Password, and OC4J Instance Name. Check the Configure this as an Administration OC4J Instance 
checkbox. Do not check the cluster topology check box. 

Important Remember the OC4J Administrator Password. It is required during the Agile PLM 
application JMS resource configuration and deployment. 

For more information, see the complete Oracle Application Server installation documentation. 

What To Do Next 

Install the Agile Application Server by starting the Agile PLM installer and following the instructions 
in online help. See ―Installing Agile PLM.‖ 

Configuring JMS Resources and Deploying the 
Agile Application 

After you install the Agile Application Server, you are ready to configure JMS resources and deploy 
the application. 

Note For UNIX operating systems, substitute forward slashes for back slashes in the 
steps below. 

To deploy the Agile application: 

1.  Windows: Open a Command Prompt window. 

UNIX: Open a terminal window and log on as the user who installed Oracle Application Server. 

2. Restart the Oracle Application Server instance: 
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oracle_home\opmn\bin\opmnctl stopall 

oracle_home\opmn\bin\opmnctl startall 

3. Check the status of the Oracle Application Server (OC4JGroup) and HTTP_Server 
components: 

oracle_home\opmn\bin\opmnctl status 

Both components should be alive. 

4.  Run the configuration script to configure the Agile application-related JMS settings: 

Windows: \AGILE_HOME\agileDomain\bin\configure.cmd <OC4Jadmin Password> 

UNIX: /AGILE_HOME/agileDomain/bin/configure.sh <OC4Jadmin Password> 

After configuration, messages similar to the following should appear: 

Creating Topic: Rollup Queue 
Command was successful 
Creating Topic: sync_topic 
Command was successful 
JMS Confguration completed. 

5. Deploy the Agile application: 

Windows: \AGILE_HOME\agileDomain\bin\DeployAgilePLM.cmd <OC4Jadmin Password> 

UNIX: /AGILE_HOME/agileDomain/bin/DeployAgilePLM.sh <OC4Jadmin Password> 

6. Check the default_group~home~default_group~1.log file in the following directory to verify that 
the Agile application is deployed: 

oracle_home\opmn\logs\ 

What To Do Next 

Verify your Agile Application Server. See the next section. 

Verifying Your Agile Application Server 

Once the Agile application is deployed, you should verify that the system works before installing 
other Agile PLM components. The simplest test is to log into Agile Web Client. 

Before using Agile Integration Framework (AIF) products such as Agile Integration Services (AIS) or 
the Agile SDK, you must ensure that the system is properly configured. This involves checking 
whether Web services and Agile SDK clients can connect successfully to the Agile Application 
Server. You must also make sure that HTTP ports are configured correctly on your server. 

For more information about using AIS and the Agile SDK to develop custom solutions for Agile 
PLM, see the separate Agile Integration Services Developer Guide and the Agile SDK Developer 
Guide, respectively. 

Verifying the Agile Application Server Login 

After you deploy the Agile application, test whether you can log in. 
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To start the Agile Application Server and test logging in: 

1.  Open a Web browser. 

2.  Test the login using the following URL: 

http://<hostname>.<domain>:<port>/<appserver_virtual_path>/PLMServlet   

For example, the URL might look something like this: 

http://plmserver.yourcompany.com:7777/Agile/PLMServlet   

Note The URL is case-sensitive. 

Important If you are configuring a separate reverse-proxy web server for the application, then 
you should NOT provide users with the application server URL. The hostname and 
port number for the reverse-proxy may be different from the application server and 
thus the reverse-proxy web server alias and port should be used by Agile Web client 
end users. The Application Server URL is a direct path to the Application Server, and 
it should be used only for testing and troubleshooting purposes. 

A login window appears. 

3.  If you have not added Agile PLM users, type admin for the user and agile for the password. 
 

Checking Whether Agile Web Services Work 

Before trying to compile and run the sample AIS web service clients, or developing custom web 
service extensions to the Agile PLM system, make sure your server is working properly. Try 
accessing the following URLs to see if they correctly return WSDL from the server. 

1.  http://agileserver/virtualPath/integration/ws/Importer?wsdl 

2.  http://agileserver/virtualPath/integration/ws/Export?wsdl 

3.  http://agileserver/virtualPath/integration/ws/ResponseService?wsdl 

All three URLs should return WSDL. If any do not, contact Customer Support. 

Checking Whether the Agile SDK Works 

If you purchased a license to the Agile SDK, Agile PLM provides both server-side and client-side 
components that allow you to develop Java programs and web services that extend the functionality 
of Agile PLM and help you integrate it with other applications. Before beginning to develop Agile 
SDK programs, make sure your system is working properly. You should be able to establish a 
connection with the Agile Application Server or the Web proxy server used for the Agile PLM 
system. You should also be able to create an Agile PLM session and download classes from the 
server. 

Checking Your Connection 

To check your connection, access the following servlet URL that is installed with Agile PLM: 

http://<servername>.<domain>:<port>/<appserver_virtualPath>/ServerAPIProperties 

For example, the URL might look something like this: 

http://plmserver.yourcompany.com:7777/Agile/PLMServlet
http://agileserver/virtualPath/integration/ws/Importer?wsdl
http://agileserver/virtualPath/integration/ws/Export?wsdl
http://agileserver/virtualPath/integration/ws/ResponseService?wsdl


 Chapter 4: Configuring the Agile Application Server 

 

 

v9.2.2.7 23  

  

http://plm.yourcompany.com/Agile/ServerAPIProperties 

The servlet should return the following information: 

 Minimum Agile API version needed to connect to the server 

 Current Agile PLM server version 

 Current Agile PLM release 

 Agile PLM session class 

 Agile PLM authenticator class 

 Agile PLM application server type 

 name/value pairs for environment variables 

If the page cannot be found, you are unable to connect to the server. There are several possible 
causes for the problem: 

 You typed the URL incorrectly. 

 The server may be down temporarily. 

 You may be experiencing problems with your network. 

Whatever the cause, you must fix the problem before you can run an Agile SDK client. If you need 
help, contact your company’s Help Desk or your Agile PLM administrator. 

Configuring HTTP Ports Correctly 

If you can connect to the server, but your Agile SDK program has trouble creating an Agile PLM 
session on Oracle Application Server (OAS), it could be because the HTTP server is incorrectly 
configured. For more information, see ―Configuring Oracle HTTP Server on page 24‖. 

Granting Write Permission to the AgileSDK.cache and 
sdk.extensions.lib Folders 

When you run an Agile SDK client program, it connects to the Agile Application Server and 
automatically downloads the classes it needs into a local cache folder named AgileSDK.cache. 
Similarly, when you run a process extension from one of the Agile PLM clients or invoke a web 
service extension, the server automatically copies any updated libraries into a folder named 
sdk.extensions.lib before loading them. On Windows, these folders are created automatically in the 
c:\Documents and Settings\<username> folder and there is never any need to modify them. 
However, on Unix-based operating systems, the system administrator must create the 
/tmp/AgileSDK.cache and /tmp/sdk.extensions.lib directories and grant users write access to them. 

If you don’t have write access to the /tmp/AgileSDK.cache and /tmp/sdk.extensions.lib directories, 
you won’t be able to run Agile SDK client programs, use process extensions from Agile PLM clients, 
or use Agile PLM web service extensions. Please see your system administrator and make sure 
you have proper access to those directories. 

Alternatively, an Agile SDK client program can programmatically change the location of the 
AgileSDK.cache directory at run time. For example, you can use the java.io.tempdir option of the 
Java Virtual Machine to specify a temp directory where all users have write access. 

http://plm.yourcompany.com/Agile/ServerAPIProperties
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Setting the sdk.extensions Property 

If your company uses the Agile SDK to develop process extensions or web service extensions, the 
finished programs are copied to the AGILE_HOME\integration\sdk\extensions folder located on the 
Agile Application Server. From there, the server uses special-purpose class loaders to load the 
programs when they are invoked. 

The agile.properties file located in AGILE_HOME\agileDomain\config contains an sdk.extensions 
property that specifies the location of the extensions folder. If process extensions or web service 
extensions don’t run successfully, it could be because the sdk.extensions property is set incorrectly 
and does not match the location where the programs have been placed. 

Note Ordinarily, you should never need to edit the agile.properties file. The 
sdk.extensions property should be set correctly when you install Agile PLM. If you 
modify the sdk.extensions property, you must restart the server. 

 

Configuring Oracle HTTP Server 

Oracle HTTP Server is a version of the Apache Web Server that is included with your installation of 
Oracle Application Server. There are several problems that can occur with Agile PLM if  Oracle 
HTTP Server is configured incorrectly. For example, you may have trouble creating an Agile 
session from an Agile SDK program. Or you may have trouble importing data from the Microsoft 
Excel-based client. To fix these problems, you must reconfigure the Oracle HTTP Server. 

The main configuration file for Oracle HTTP Server is httpd.conf. It is located in the following 
directory: 

Windows: oracle_home\Apache\Apache\conf 

UNIX: oracle_home/Apache/Apache/conf 

Open the httpd.conf file to edit it. You can use any text editor. 

Make sure the Port and Listen values in httpd.conf are set correctly.The value for Port should reflect 
the listen port of the reverse-proxy web server (if present) or of Oracle HTTP Server (if no reverse-
proxy web server is configured). The value for Listen should reflect the listen port of the Oracle 
HTTP Server. The value for ServerName should reflect the alias or hostname of the reverse-proxy 
web server (if present) or of Oracle HTTP Server (if no reverse-proxy web server is configured). If 
no reverse-proxy web server is used, then here is what the Port section of the httpd.conf file should 
look like: 

# Port: The port to which the standalone server listens.  Certain 
firewall 

# products must be configured before Apache can listen to a specific 
port. 

# Other running httpd servers will also interfere with this port.  
Disable 

# all firewall, security, and other services if you encounter problems. 

# To help diagnose problems use the Windows NT command NETSTAT -a 

# 

Port 7777 

Listen 7777 
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Note If port 7777 is already being used, Oracle HTTP Server listens on the next available 
port number between a range of 7777 and 7877. 

Make sure the server status reports section of the httpd.conf file uses the fully qualified domain 
name for your Oracle HTTP Server. Here is what that section should look like: 

# Allow server status reports, with the URL of 
http://servername/server-status 

# Change the ".your_domain.com" to match your domain to enable. 

# 

<Location /server-status> 

    SetHandler server-status 

    Order deny,allow 

    Deny from all 

    Allow from localhost servername.your_domain.com servername 

</Location> 

Important If you modify the httpd.conf file, you must restart Oracle HTTP Server. 

 

Setting the Temp Directory 

When you installed Oracle Application Server, you logged into your operating system as a particular 
user. You should always log in as that user to manage your installation. Several variables are set in 
the configuration when you install Oracle Application Server. One of them is the TMP environment 
variable, which sets the temporary directory that the server uses. On Windows, by default the TMP 
environment variable for Oracle Application Server is set to the temp directory of the user that 
installed the software. 

Several Agile PLM services use the temporary directory to store temporary files. If you inadvertently 
delete the temporary directory that Oracle Application Server is using, Agile PLM services that were 
using the temporary directory may no longer operate successfully. 

If you notice that Agile PLM export and import operations are no longer working, check the 
application server log and see if there is an error like this: 

Exception msg:java.rmi.RemoteException: An error was encountered while 
exporting data: com.agile.util.exception.CMAppException: C:\Documents 
and Settings\<user>\Local 

Settings\Temp\2\AgilePC9Extract\223673754\223673754.xml (The system cannot find 
the path specified) 

The message confirms that Oracle Application Server can no longer find the temporary directory. To 
resolve the problem, you can recreate or restore the temp directory, or set the TMP environment 
variable for Oracle Application Server to another location. 

To reset the temporary directory for Oracle Application Server: 

1.  Log in as the user used to install Oracle Application Server. 

2.  Open the opmn.xml file located in the \oracle_home\opmn\conf directory. 

3.  Look for the following section: 

<ias-instance id="instance_name.server_name.domain"> 

http://servername/server-status
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  <environment> 

    <variable id="TMP" value=temp_directory /> 

  </environment> 

4.  Change the temp_directory value to a valid directory. It must be a directory that the user who 
manages OAS can access and write to. 

5.  Save the file. 

6.  Restart Oracle Application Server. 
 

Recompiling Agile PLM JSP Files 

If you have edited Agile PLM JSP files to modify the Agile Web Client user interface, you need to 
modify the Oracle Application Server main_mode parameter to make sure the JSP files are 
recompiled before they are loaded. 

For information about how to modify the Agile Web Client user interface, please see your Oracle Consulting - 
Agile Practice representative. 

 

To change the main_mode parameter to recompile: 

1.  Windows: Change to the \oracle_home\j2ee\home\config\ directory. 

UNIX: Change to the /oracle_home/j2ee/home/config/ directory. 

2.  Edit the global-web-application.xml file. Change the value of the main_mode parameter to 
recompile, as follows: 

<init-param> 

      <param-name>main_mode</param-name> 

      <param-value>recompile</param-value> 

</init-param> 
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Chapter 5 

Configuring Application Server Clusters 
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 Configuring jndiurl.properties and pcclient.jnlp .................................................................................................... 31 
 Starting the Agile Cluster ..................................................................................................................................... 31 
 Testing the Agile Cluster ...................................................................................................................................... 32 
 Configuring the JNLP MIME Type on UNIX ......................................................................................................... 32 

 
 

About Agile Application Server Clusters 

Agile takes advantage of clustering capability provided by the supported application servers. A 
cluster is a group of servers that work together to provide a more scalable, more reliable application 
platform than a single server. A cluster appears to its clients as a single server, but is actually a 
group of servers acting as one. A cluster provides two key advantages over a single server: 

 Scalability: The capacity of a cluster is not limited to a single server or a single machine. New 
servers can be added to the cluster dynamically to increase capacity. If more hardware is 
needed, a new server on a new machine can be added. If a single server cannot fully utilize an 
existing machine, additional servers can be added to that machine. But this is not a supported 
configuration unless you are using a product like VMWare or partitions or containers. 

 High-Availability: A cluster uses the redundancy of multiple servers to insulate clients from 
failures. The same service can be provided on multiple servers in the cluster. If one server fails, 
the surviving members can continue to serve the application. The ability to fail over from a 
failed server to a functioning server increases the availability of the application to clients. 

Traffic to multiple application servers needs to be managed or balanced by some device in-between 
the server cluster and the clients. There are two main components that provide this capability; 
reverse-proxy web servers or load balancing hardware.  

Choosing Oracle Application Server Components to Install 

You must have at least two servers to install an application server cluster. One server acts as the 
primary server and the other acts as the secondary server. The directory structure should be the 
same on both servers. 

Oracle Application Server must be installed on the primary and secondary server before you install 
any Agile components. For information on how to install Oracle Application Server, see ―Installing 
Oracle Application Server‖.  
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Make sure that the OC4J administrator password for Oracle Application Server is the same on all 
servers in the cluster. 

For more information, see the complete Oracle Application Server installation documentation from 
Oracle. 

Installing Agile PLM on the Primary Server 

Install the Agile Application Server by starting the Agile PLM installer and following the instructions 
in online help. See ―Installing Agile PLM.‖ 

During the installation, make sure the following steps are performed: 

1. Select Advanced Mode on the Installation Mode panel. 

2. Select Cluster installation on the Installation Type panel. 

3. Enter the multicast address and port number which are used as a part of the dynamic discovery 
mechanism for managing Oracle nodes in a cluster environment. 

Note All of the nodes in the cluster topology must be configured to use the same multicast 
address and port number. 

4. Select Primary Server on the Clustered Application Server Type panel. 

5. If installing File Managers that are to be load-balanced, make sure the file manager storage 
location is a shared location for the primary and secondary server. 

 

Installing Agile PLM on the Secondary Server 

Install the Agile Application Server by starting the Agile PLM installer and following the instructions 
in online help. See ―Installing Agile PLM on page 9." 

During the installation, make sure the following steps are performed: 

1. Select Advanced Mode on the Installation Mode panel. 

2. Select Cluster installation on the Installation Type panel. 

3. Enter the multicast address and port number which are used as a part of the dynamic discovery 
mechanism for managing Oracle nodes in a cluster environment. 

Note All of the nodes in the cluster topology must be configured to use the same multicast 
address and port number. 

4. Select Secondary Server on the Clustered Application Server Type panel. 

5. If installing File Managers that are to be load-balanced, make sure the file manager storage 
location is a shared location for the primary and secondary server. 
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Configuring the Primary and Secondary Servers 

The following steps must be performed on each server in the cluster before the application is 
deployed: 

1. Start the application server instance: 

oracle_home\opmn\bin\opmnctl startall 

2. Check the status of the Oracle Application Server instance: 

oracle_home\opmn\bin\opmnctl status 

The HTTP_Server and OC4J components of Oracle Application Server should be alive. 

3. In a Command Prompt window, go to the AGILE_HOME\agileDomain\bin directory and run the 
joinCluster command. 

This command joins the instance into the cluster. 

Configuring JMS Resources and Deploying the 
Agile Application in a Cluster 

After the Agile PLM application server has been installed on the primary and secondary servers, 
you can now deploy the Agile application. You should deploy Agile on the primary server. It is 
automatically synchronized to the secondary servers in the cluster. 

Before deploying the application, make sure the following actions are taken: 

 Stop Oracle Application Server. Make sure that the network adapter is configured on your LAN 
and that the other cluster members are accessible via 'ping'.  

 On Windows, disable the loopback adapter and remove its IP address from the hosts file. 

 Verify that the database schema is upgraded to Agile PLM 9.2.2.4. 

 Verify that the HTTP_Server and OC4J components are alive on the primary and secondary 
servers. 

Note For UNIX operating systems, substitute forward slashes for backward slashes in the 
following steps. 

To deploy the Agile application: 

1.  Windows: Open a Command Prompt window on the primary server. 

UNIX: Open a terminal window on the primary server and log on as the user who installed 
Oracle Application Server. 

2. Run the configure script to configure JMS resources for the Agile application: 

Windows: \AGILE_HOME\agileDomain\bin\configure.cmd <OC4Jadmin Password> 

UNIX: /AGILE_HOME/agileDomain/bin/configure.sh <OC4Jadmin Password> 

After configuration, the messages similar to the following should appear: 
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Creating Topic: Rollup Queue 
Command was successful 
Creating Topic: sync_topic 
Command was successful 
JMS Confguration completed. 

3. Deploy the Agile application: 

Windows: \AGILE_HOME\agileDomain\bin\DeployAgilePLM <OC4Jadmin Password> 

UNIX: /AGILE_HOME/agileDomain/bin/DeployAgilePLM.sh <OC4Jadmin Password> 

The application should be deployed on the primary and secondary servers. 

4. Check the default_group~home~default_group~1.log file in the following directory to verify that 
the Agile application is deployed: 

\oracle_home\opmn\logs\ 

5. Restart the Oracle Application Server instance on all servers: 

\oracle_home\opmn\bin\opmnctl stopall 

\oracle_home\opmn\bin\opmnctl startall 

 
 

What To Do Next 

Configure a load balancer or a reverse-proxy web server for your Agile PLM cluster. For more 
information, see ―Configuring the Load Balancer‖ and ―Configuring a Web Proxy Server for Agile 
PLM.‖ 

Configuring the Load Balancer 

A load balancer is deployed to balance user load across a cluster and to avoid directing traffic to a 
downed cluster member. When external users need access to Agile, this device is deployed in the 
DMZ. The load balancer does not need to be installed in the DMZ if Agile PLM is only accessed 
internally from within the corporate firewall. Load balancers can be used with the Java Client and 
the Web Client. 

To configure a load balancer: 

 Configure three virtual IP addresses, one for the application server web client (port 7777 by 
default), one for the application server Java client (port 23791, internal users only), and one for 
the File Manager (port 8080 by default). 

 Set the load balancer policy to Round-robin. 

To access the system after you have configured the load balancer, use an alias for the virtual IP 
address of the load balancer in the Agile web and Java client URLs. The following URL is an 
example: 

http://loadbalancer.mydomain.com/Agile/PLMServlet 

or 

http://loadbalancer.mydomain.com/Agile/PLMServlet


 Chapter 5: Configuring Application Server Clusters 

 

 

v9.2.2.7 31  

  

ormi://loadbalancer.mydomain.com/Agile 
 

Configuring jndiurl.properties and pcclient.jnlp 

To configure jndiurl.properties and pcclient.jnlp on secondary servers: 

1. Stop the Web proxy server. 

2. Stop Oracle Application Server on each server in the cluster. 

3. On each secondary server, open the following file in a text editor: 

/oracle_home/j2ee/home/applications/APP-INF/classes/jndiurl.properties 

4. Edit the URL to point to the secondary server: 

server2=ormi://<secondary_server_hostname>.<domain>:<port>/Agile 

where 

 <secondary_server_hostname> is the hostname for the secondary server. 

 <domain> is the fully qualified domain name. 

 <port> is the ORMI port number (default port: 23791). 

5. Save the jndiurl.properties file. 

6. On each secondary server, open the following file in a text editor: 

/oracle_home/j2ee/home/applications/Agile/JavaClient/pcclient.jnlp 

7. Find the following tags and edit the values listed below: 

serverURL: 

<argument>serverURL=ormi://<secondary_server_hostname>.<domain>/Agile</argument> 

where 

 <secondary_server_hostname> is the hostname for the secondary server. 

 <domain> is the fully qualified domain name. 

8. Save the file. 

9. Start the Oracle Application Server on each server in the cluster. 

10.  Start the Web proxy server. 

 
 

Starting the Agile Cluster 

Once the Agile application is deployed to every Oracle Application Server in the cluster, the cluster 
should be active. You can use the opmnctl command-line interface to stop and start individual 
servers in the cluster. 
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Testing the Agile Cluster 

Use the following URLs to test each server in the cluster and the load balancer: 

Web Client 

http://hostname.domain.com:<port_no>/<app-serverVirtualPath>/PLMServlet 

For example, if your hosts are named host1, host2, and host3, the Web Client URLs could look like 
this: 

http://host1.mydomain.com:7777/Agile/PLMServlet 

http://host2.mydomain.com:7777/Agile/PLMServlet 

http://host3.mydomain.com:7777/Agile/PLMServlet 
 

Java Client 

http://hostname.domain.com:<port_no>/JavaClient/start.html 

For example, if your hosts are named host1, host2, and host3, the Java Client URLs could look like 
this: 

http://host1.mydomain.com:7777/JavaClient/start.html 

http://host2.mydomain.com:7777/JavaClient/start.html 

http://host3.mydomain.com:7777/JavaClient/start.html 
 

Load Balancer 

If you use a load balancer for your application server cluster, test the entire system by going to the 
load balancer URLs for Web Client and Java Client: 

http://loadbalancer.domain.com/Agile/PLMServlet 

http://loadbalancer.domain.com/JavaClient/start.html 
 

Configuring the JNLP MIME Type on UNIX 

A JNLP file is an XML document that describes a Java application to be launched by Java Web 
Start. To successfully download and install applications using Java Web Start, you must configure 
the JNLP MIME type for your server. 

Add the following line to the mime.types file in the /oracle_home/Apache/Apache/conf directory of each 
application server in the cluster: 

application/x-java-jnlp-file            JNLP 

http://hostname.domain.com:%3cport_no%3e/%3capp-serverVirtualPath%3e/PLMServlet
http://host1.mydomain.com:7777/Agile/PLMServlet
http://host2.mydomain.com:7777/Agile/PLMServlet
http://host3.mydomain.com:7777/Agile/PLMServlet
http://hostname.domain.com:%3cport_no%3e/JavaClient/start.html
http://host1.mydomain.com:7777/JavaClient/start.html
http://host2.mydomain.com:7777/JavaClient/start.html
http://host3.mydomain.com:7777/JavaClient/start.html
http://loadbalancer.domain.com/Agile/PLMServlet
http://loadbalancer.domain.com/JavaClient/start.html
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Chapter 6 

Configuring the File Manager 

This chapter includes the following: 

 About File Management ....................................................................................................................................... 33 
 Configuring the File Manager .............................................................................................................................. 37 
 Starting the File Manager .................................................................................................................................... 41 
 Validating the File Manager Installation ............................................................................................................... 41 

 
 

About File Management 

The File Manager manages files in a repository or vault in the file system. A File Manager provides 
a place to store and retrieve files locally or remotely. The File Manager can be installed on the same 
machine as the Agile Application Server or on a separate machine. The server can also be installed 
in a cluster or distributed across geographic regions. 

The Agile Viewer communicates with the File Manager which in turn makes calls to the Agile 
Application server using the HTTP protocol. Because of this, if Agile View Server is licensed, it is 
recommended that the Agile View Server be installed on the same machine as the Agile File 
Manager, if sufficent resources are available. 

In the preferred clustered environment, File Managers run on each application server node 
managing a shared drive. In a distributed environment, files are stored locally for efficient 
downloads and uploads. If a file is not found on a local file manager, the file is replicated from the 
primary file manager. The primary file manager is the file manager that is local to the application 
server. 

Distributed File Managers 

Multiple Agile File Managers can be deployed in a distributed configuration with or without a 
reverse-proxy web server (Microsoft IIS or Apache HTTP Server) in the DMZ. A Distributed File 
Manager configuration allows you to install additional file managers at remote locations so that 
remote sites can store and retrieve files locally, while still making the files available to the Agile PLM 
system. This can reduce the download time by placing file managers close to remote clients. 

The determination for using distributed file management is based on your Agile end-user locations 
and network configuration. In general, the following criteria can help you to determine if you need 
additional file managers: 

 Multiple remote locations 

If you have multiple remote sites connected over a WAN, clients at remote locations who need 
to store and retrieve files from the main file manager can experience large time delays. 

 Reducing inter-network traffic 

If your network is divided into subnets to reduce network traffic, then you should consider 
putting a file manager in each subnet that contains Agile users to reduce your intersubnet 
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network traffic. 

The usage model for a distributed file manager configuration is as follows: 

 The File Manager located nearest to the application server should be designated the primary 
File Manager. 

 Users upload and download files from their preferred File Manager. 

 File replication between File Managers is on-demand. When a remote user requests a file that 
does not exist on their preferred File Manager, the system copies the file to the remote user's 
preferred File Manager. 

 Checking out and checking in files is the same as adding and getting files. 

 Viewing a file or viewing a redline file is similar to getting a file. 

 Redlining a file is the same as adding a file. 

 Deleting a file only removes references to the file. Use the vault utility to clean up additional 
files on non-primary file managers. 

 

Deployment Configurations 

You can deploy the File Manager in either a standalone or cluster configuration. 
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Standalone 

The following figure shows a single server standalone deployment configuration. The web server in 
the DMZ forwards calls to the Application Server as well as the File Manager. 

 

If you plan to install the Application Server and File Manager on the same box (co-deploy), choose 
both components during Agile PLM installation. 

Cluster 

The preferred cluster deployment configuration is shown in the following figure. Each node in the 
cluster has the Application Server and File Manager deployed. File Managers have a shared disk 
for file vaults. Each File Manager communicates with the local application server for optimized 
performance. The File Managers join in a Tomcat cluster to support failovers. The Load Balancer 
exposes two virtual IP addresses, one for the application server and one for the File Manager. 
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When installing this type of cluster, choose both the Application Server and File Manager 
components during Agile PLM installation before selecting the Cluster configuration. 
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You can also choose to deploy the File Manager cluster and Application Server cluster on separate 
machines, but that configuration requires more hardware. If you choose to install this type of setup, 
the Application Servers and File Managers should be installed separately before configuring and 
validating. 

 
 

Configuring the File Manager 

After installing the File Manager and setting up a load balanger or reverse-proxy server for it, you 
must configure the File Manager settings in the Java Client. 

Note Before configuring the File Manager, make sure you set up a load balancer or 
reverse-proxy server. 

To configure File Manager settings: 

1.  Start the Agile Application Server. 

oracle_home\opmn\bin\opmnctl startall 

2.  Start the Agile Java Client, as described in ―Installing and Configuring Agile Java Client on 
page 77‖. 

3.  Log in as an Agile Administrator user. 

4.  Click the Admin tab. 

5.  Choose Server Settings > Locations. The Server Location window appears. 

6.  Click the File Manager tab to bring it forward. 

7.  double-click the entry to display the File Manager dialog box. 
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8.  Click the Advanced button and check the Viewer Content URL. 

 

 

 

9.  Enter the value of the File Manager URL. 

The File Manager URL is the URL the Agile Web Client connects to. The format is: 

 http://<proxy/loadbalancer>:<port>/<fileserver_virtual_path>/AttachmentServlet 

10.  Click the Standard Vault Type to display the drop-down list. 

You can choose to have Standard or Custom vault. A standard vault is the default vault type that 
contains the new files and redlines, while a custom vault allows you to attach a disk of data to 
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Agile PLM as-is without reorganizing the files. A custom vault is always set up as read-only. 

You can attach an arbitrary file structure to the File Manager without the files being uploaded. 
Refer to the Agile PLM Import and Export Guide for more information on how to configure 
FileLoad for custom vaults. 

11.  Enter a description of the vault in the Description field. 

12.  Verify that the primary location where the files are stored in the Base Storage Directory field is the 
same location you entered during installation. The default location is \files. The location can be 
a shared network storage directory, such as a Storage Area Network (SAN). 

Important Do not specify a mapped drive which may not be mapped automatically after a reboot. 
Instead, specify a local drive or UNC name including directory path, like this: 

\\fileserver\filevault 

13.  Enter a location where the purged (deleted) files are automatically moved in the Purge Directory 
field. The default location is \files\purge.  The location can be a shared network storage 
directory, such as a Storage Area Network (SAN). 

Important Do not specify a mapped location. Instead, specify a local drive or UNC name 
including directory path, like this: 

\\fileserver\filevault\purge 

14.  Set the vault as Read-Write or Read-Only from the Category drop-down list. Each File Manager 
can have only one Read-Write vault. 

If you have multiple vaults, then the additional vaults should be defined as Read-Only vaults. 

15.  Click the plus-sign  to add additional vaults. 

16.  Click OK when done. 

17.  Start the File Manager (Tomcat). For instructions, see the next section, ―Starting the File 
Manager.‖ 

There are additional configuration settings used to fully configure File Manager through the Java 
Client. These settings are: 

 Filename Prefix (Preferences) 

 Checksum computation (Preferences) 

 DFM Optimized Replications (Preferences) 

For more information on these additional settings, see the Agile PLM Administrator Guide. 

Reconfiguring File Manager After Setting Up a Web Proxy 
Server 

If you set up a Web proxy server for Agile File Manager that is different from the server or port you 
specified when you installed Agile PLM, you must make sure that File Manager points to the proxy 
server on the correct port. Otherwise, File Manager may not start successfully and Agile PLM 

file:\\fileserver\filevault
file:\\fileserver\filevault\purge
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clients won’t be able to access file attachments. 

For instructions on setting up a Web proxy server for File Manager, see ―Configuring a Web Proxy 
Server for Agile PLM.‖ 

To configure File Manager after setting up a Web proxy server: 

1. Configure File Manager locations in Java Client. See ―Configuring the File Manager on page 
33‖. 

2. Stop the File Manager. 

3. Backup the existing File Manager configuration: 

a. Change to the AGILE_HOME\Tomcat\webapps directory.  

b. Verify there is a directory named Filemgr under the webapps directory. 

c. If the Filemgr directory exists, then perform the following: 

cd .. 

mkdir webapps.old 

Windows: move webapps\Filemgr webapps.old 
UNIX: mv webapps/Filemgr webapps.old 

4. Create a backup of the AGILE_HOME\agileDomain\applications\webfs.war file. 

5. Create an empty temporary directory. Make sure there are no spaces in the path to the 
temporary directory. 

6. Copy the webfs.war file to the temporary directory. 

7. From a command line, change to the temporary directory and run the following commands: 

set PATH=\AGILE_HOME\jdk\bin;%PATH% 

jar -xvf webfs.jar 

8.  After the files are extracted, change to the WEB-INF\classes\com\agile\webfs\configuration 
directory. 

9. Using a text editor, open the server.conf file for File Manager. 

10.  Find the file.server.url entry, and update it to reflect the proxy server hostname or alias and 
port number. After you modify the file.server.url entry, it should look something like this: 

file.server.url  =http://webserver.company.com:80/Filemgr/services/FileServer 

Note The file.server.url entry must match the File Manager Internale Locator entry 
(definied in Java client: Server Settings > Locations) or the File Manager will not 
initialize successfully. 

11.  Save the server.conf file. 

12. Delete the webfs.war file from the temporary directory. 

13. From a command line, run the following command to recreate the webfs.war file: 

jar -cvf webfs.war * 

14. Copy the newly created webfs.war file to the \AGILE_HOME\agileDomain\applications 
directory.  

15. Perform steps 4-14 on the \AGILE_HOME\Tomcat\server\lib\agile-sso.jar file. Make sure you 
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create a backup of the agile-sso.jar file. 

16. Copy the newly created agle-sso.jar file to the \AGILE_HOME\tomcat\server\lib directory. 

17.  Restart the File Manager (Tomcat). 
 

Starting the File Manager 

After you have configured the File Manager, you can start the server. 

To start the File Manager on Windows: 

1.  Choose Start >  Administrative Tools > Services. 

2.  Start the Apache Tomcat service. 

You can check for errors in the stdout and stderr logs in the AGILE_HOME\Tomcat\logs 
directory. 

To start the File Manager on UNIX: 

1.  Open a terminal window. 

2.  Change to the /opt/AGILE_HOME/Tomcat/bin directory. 

3.  Set and export the JAVA_HOME variable on the command line: 

> JAVA_HOME=/opt/AGILE_HOME/jdk 

> export JAVA_HOME 

4.  Start the File Manager: 

> ./startup.sh 

 
 

Validating the File Manager Installation 

To verify that the File Manager installed successfully, check the following URL: 

http://<fileserver_host>:<port>/<fileserver_virtual_path>/Configuration 

For example, you might type the following URL: 

http://filevault.mycompany.com:8080/Filemgr/Configuration 

If you are using a Web proxy server for File Manager, the URL might look like this: 

http://webproxy.mycompany.com:80/Filemgr/Configuration 

After a moment, the File Manager Configuration page should display. This page tests the File 
Manager and Application Server connections. If Success is listed in the Status column for all 
connections, your installation was successful. 

http://filevault.mycompany.com:8080/Filemgr/Configuration
http://webproxy.mycompany.com/Filemgr/Configuration
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Chapter 7 

Configuring a Web Proxy Server for Agile 
PLM 

This chapter includes the following: 

 Overview .............................................................................................................................................................. 43 
 Configuring IIS as a Proxy Server for Agile PLM ................................................................................................. 45 
 Configuring IIS as a Proxy Server for Agile File Manager ................................................................................... 47 
 Configuring Apache Web Server as a Proxy Server for Agile PLM and Agile File Manager ............................... 49 
 Logging In to the Agile Web Client ...................................................................................................................... 54 
 Troubleshooting the Agile Web Client ................................................................................................................. 54 

 

Important When you configure a Web proxy server for Agile PLM, follow the sequence 
recommended in ―Web Proxy Server Installation Checklist on page 4‖. 

 
 

Overview 

The Agile Web client is a fully functional Web interface that allows Agile-enabled manufacturers to 
securely provide internal users and trusted supply chain partners access to Agile PLM.               

To connect to the Agile Web Client on a Web proxy server, Agile Web proxy files must be installed 
on the Web server. Agile Web Client uses Microsoft Internet Information Services (IIS) or Apache 
Web Server. The Agile Web client connects to an Agile Application Server in the same manner as 
all other Agile Application Server clients. Secure access is maintained using SSL encryption with 
HTTPS and is recommended for the Internet. Standard firewall configurations are supported by the 
Web server. 

Note If you are using an Oracle Application Server cluster on Windows, you must use a 
load balancer instead of a Web proxy server to balance user load across the cluster. 

 

Agile Internet Security 

A Web browser uses the Agile Web client to communicate with the Agile Application Server over the 
Internet using the HTTPS protocol, which uses the Secure Sockets Layer (SSL) protocol. SSL is a 
standard Internet connection-based protocol for secure communications.                  

Recommended Security Practices 

It is important that you change all default passwords for both Agile PLM and the database. In 
addition, users should change their passwords at least every 30 days. 
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Configuring Internet Information Server 

Before you install Agile Web proxy files on Windows, a Microsoft Internet Information Server (IIS) 
must be installed on the same computer. In addition, IIS must be configured as follows:        

1.  Choose Start > Administrative Tools > Internet Information Services (IIS) Manager, and create a new 
web site called Agile PLM Web Site. For more information on how to create a web site, see the 
Internet Information Server documentation online at the Microsoft TechNet: 
http://technet.microsoft.com/ 

Note Due to security vulnerabilities, we recommend that you don’t use the Default Web 
Site installed with Internet Information Server. You can either delete or disable the 
Default Web Site. 

2.  Right-click the Agile PLM Web Site, and choose Properties from the shortcut menu. 

3.  Select the Directory Security tab and click Edit for Anonymous Access and Authentication 
Control. 

4.  Make sure Enable Anonymous Access is checked. 

5.  Uncheck Integrated Windows authentication. 

6.  Click OK. 

Also, search the \\winnt\system32 folder for the wininet.dll file. The file must be at least version 
5.00.2919.6305 or later. Install at least Internet Explorer version 5.00.2919.6305 to update the DLL 
file.       

For security reasons, Agile recommends installing Agile Web proxy files on a server separate from 
other Agile PLM servers. 

Firewall Configuration 

An external user typically runs the Agile Web client in a browser from outside the corporate network. 
The client typically communicates over the Internet to the Agile servers behind a corporate firewall.      

If you want to use HTTPS, firewalls must be configured to allow for connectivity from the Agile Web 
clients to the DMZ reverse-proxy web server or load balancer and from the DMZ reverse-proxy web 
server or load balancer to the Agile PLM Application Servers and File Managers. 

The corporate firewall on the Agile application side must be configured to allow: 

 Incoming HTTPS connections from the Internet to the Web server 

 Outgoing TCP/IP connections from the Web server to the Application Server          

Important On Windows, encryption is supported only between IIS and the client’s browser, not 
between IIS and the Application Server. Do not put a certificate on the Application 
Server. 

 

http://technet.microsoft.com/
file:\\winnt\system32%20folder%20for%20the%20wininet.dll
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Configuring IIS as a Proxy Server for Agile PLM 

When you install the Agile PLM Web Proxies component, the setup program creates the 
AGILE_HOME\AgileProxies folder. For example, if you accepted the default installation location at 
D:\Agile\Agile9224, the AgileProxies folder appears in that folder. The AgileProxies folder contains 
the following files that enable communication between the IIS Web server and the Agile Application 
Server: 

 oracle_proxy.dll — an ISAPI filter, which allows IIS to process HTTP requests 

 9ias.conf — initialization file to direct the proxy filters where to route the HTTP/HTTPS traffic 
specific to Agile PLM from IIS 

Note Make sure you can successfully ping the Application Server using the fully qualified host 
name and that the HTTP port that the Application Server is listening on is not blocked by 
a firewall. 

To configure IIS to be a Web proxy server for Agile PLM:  

1.  On the Web server computer, Choose Start > Administrative Tools > Internet Information Services 
(IIS) Manager. 

The Internet Information Services Manager window appears. 

2.  Expand the folder for Internet Information Services > servername.   

3.  right-click the Agile PLM Web Site, and choose Properties from the shortcut menu. 

The Agile PLM Web Site Properties dialog box appears. 

Note Due to security vulnerabilities, we recommend that you don’t use the Default Web 
Site installed with Internet Information Server and instead create a new Web site 
named Agile PLM Web Site. For more information, see ―Configuring Internet 
Information Server‖. 

4.  Click the Home Directory tab. 

5.  Set the permissions to Scripts and Executables. 

6.  Select the ISAPI Filters tab. 

7.  Click Add. 

The Add/Edit Filter Properties dialog box appears. 

8.  Type oproxy in the Filter Name field. 

9.  Click Browse and locate the oracle_proxy.dll file from \AGILE_HOME\AgileProxies folder. After 
you select the oracle_proxy.dll file, click Open to close the dialog box. 

10.  In the Add/Edit Filter Properties dialog box, Click OK. 

The Agile PLM Web Site Properties dialog box appears. 

11.  Click OK to close the Agile PLM Web Site Properties dialog box. 

12.  right-click the Agile PLM Web Site, and choose New > Virtual Directory from the shortcut menu. 

The Virtual Directory Creation Wizard appears. 
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13.  Click Next. 

14.  Type oproxy in the Alias field. Click Next. 

15.  On the Web Site Content Directory page, click Browse, locate the \AGILE_HOME\AgileProxies 
folder, and then Click OK. Click Next. 

16.  Check the Execute checkbox. Click Next. 

17.  Click Finish. 

18.  Select the Web Service Extensions folder. 

19.  Select All Unknown ISAPI Extensions. 

20.  Click Allow. 

21.  Close IIS Manager. 

22.  Restart IIS. 

Note To restart IIS, stop all of the IIS services through the control panel and then restart 
them, or restart the computer. This ensures that the .dll is reloaded. Do not use IIS 
Manager to restart IIS. 

 

Testing the Configuration 

After you set up the oproxy ISAPI filter, you should test whether the filter loads successfully. 

To make sure the oproxy filter added to ISAPI Filters tab is loaded properly on the Web 
server: 

1. Type the Application Server PLMServlet URL into a browser (using the reverse-proxy web 
server alias or hostname and listen port) and make sure the Agile PLM login page loads 
successfully. 

2. Select the Agile PLM Web Site node, right-click, and choose Properties from the shortcut menu. 

The Agile PLM Web Site Properties dialog box appears. 

3.  Select the ISAPI Filters tab. 

The status for the oproxy filter shows an arrow pointing up, indicating that it is loaded on the IIS 
Web server and ready to proxy all external HTTP/HTTPS requests to the Agile Web client 
server. 

Note If the arrow is not pointing up, the filter is not loaded properly. In that case, restart 
the computer. 

The IIS Web server is now ready to accept all external Agile Web clients using HTTP requests on 
standard ports 80. The IIS Web server provides a proxy to the application server running Agile Web 
clients on the port you specified during the Agile Application Server installation. 
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Configuring IIS as a Proxy Server for Agile File 
Manager 

When you install Agile Web proxies, the setup program creates the AGILE_HOME\AgileProxies 
folder. For example, if you accepted the default installation location at D:\Agile\Agile9224, the 
AgileProxies folder appears in that folder. 

The AGILE_HOME\AgileProxies folder contains the following files that enable communication 
between the IIS Web server and the File Manager (Tomcat): 

 isapi_redirect.dll - The IIS server plugin. 

 workers.properties - A file that describes the hosts and ports used by Tomcat processes. 

 uriworkermap.properties - A file that maps URL-Path patterns to Tomcat processes. 

Note If you set up a Web proxy server for Agile File Manager that is different from the 
server or port you specified when you installed Agile PLM, you must make sure that 
File Manager points to the proxy server on the correct port. For more information, 
see ―Reconfiguring File Manager After Setting Up a Web Proxy Server on page 39‖. 

To configure IIS as a proxy server for File Manager:   

1.  On the File Manager computer, open the AGILE_HOME\Tomcat\conf\jk2.properties file. 

2.  Add the following entry, replacing @AJP-PORT@ with the actual AJP port number: 

channelSocket.port=@AJP-PORT@ 

Note To see which AJP port number to enter, open the 
AGILE_HOME\Tomcat\conf\server.xml file and look for the following section: 

   <!--  Define a Coyote/JK2 AJP 1.3 Connector on port 8009   --> 

   <Connector port="8009" enableLookups="false" redirectPort="8443" debug="0" 

    protocol="AJP/1.3" /> 

3.  On the Web server computer, Choose Start > Administrative Tools > Internet Information Services 
(IIS) Manager. 

The Internet Information Services Manager window appears. 

4.  Expand the folder for Internet Information Services > servername.   

5.  right-click the Agile PLM Web Site, and choose Properties from the shortcut menu. 

The Agile PLM Web Site Properties dialog box appears. 

Note Due to security vulnerabilities, we recommend that you don’t use the Default Web 
Site installed with Internet Information Server and instead create a new Web site 
named Agile PLM Web Site. For more information, see ―Configuring Internet 
Information Server‖. 

6.  Select the ISAPI Filters tab. 

7.  Click Add. 

mailto:channelSocket.port=@AJP-PORT@
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The Add/Edit Filter Properties dialog box appears. 

8.  Type Jakarta IIS Connector in the Filter Name field. 

9.  Click Browse and locate the isapi_redirect.dll file from the AGILE_HOME\AgileProxies folder. 
After you select the isapi_redirect.dll file, click Open to close the dialog box. 

10.  In the Add/Edit Filter Properties dialog box, Click OK. 

The Agile PLM Web Site Properties dialog box appears. 

11.  Click OK to close the Agile PLM Web Site Properties dialog box. 

12.  right-click the Agile PLM Web Site, and choose New > Virtual Directory from the shortcut menu. 

The Virtual Directory Creation Wizard appears. 

13.  Click Next. 

14.  On the Virtual Directory Alias page, type Jakarta as the alias name. Click Next. 

15.  On the Web Site Content Directory page, click Browse, locate the AGILE_HOME\AgileProxies 
folder, and then Click OK. Click Next. 

16.  On the Access Permissions page, make sure the Execute checkbox is checked. Click Next. 

17.  Click Finish. 

18.  Close IIS Manager. 

19.  Open the workers.properties file in the AGILE_HOME\AgileProxies folder. 

20.  Make sure the File Manager host name is correct in the following entry: 

worker.ajp13w.host=<File Manager fully qualified host name> 

Note Make sure you can successfully ping the File Manager using the fully qualified host 
name and that the AJP port is not blocked by a firewall. 

21. Save and close the file. 

22. Restart IIS. 

Note To restart IIS, stop all of the IIS services through the control panel and then restart 
them, or restart the computer. This ensures that the .dll is reloaded. Do not use IIS 
Manager to restart IIS. 

 

Testing the Configuration 

After you set up the Jakarta IIS Connector ISAPI filter, you should test whether the filter loads 
successfully. 

To make sure the isapi_redirect filter added to ISAPI Filters tab is loaded properly on the 
Web server: 

1. Type the File Manager Configuration URL into a browser (using the reverse-proxy web server 
alias or hostname or listen port) and make sure the Configuration page loads successfully.  

2. Select the Agile PLM Web Site node, right-click, and choose Properties from the shortcut menu. 

The Agile PLM Web Site Properties dialog box appears. 
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3.  Select the ISAPI Filters tab. 

The status for the Jakarta IIS Connector filter shows an arrow pointing up, indicating that it is 
loaded on the IIS Web server and ready to proxy all requests to the File Manager. 

Note If the arrow is not pointing up, the filter is not loaded properly. In that case, restart 
the computer. 

 

Configuring Apache Web Server as a Proxy 
Server for Agile PLM and Agile File Manager 

On UNIX operating systems, you can use Apache Web Server as the Web proxy server for Agile 
PLM. If you choose the Apache Web Server when you install Agile PLM, you must specify the 
Apache Home Directory. 

Note If you set up a Web proxy server for Agile File Manager that is different from the 
server or port you specified when you installed Agile PLM, you must make sure that 
File Manager points to the proxy server on the correct port. For more information, 
see ―Reconfiguring File Manager After Setting Up a Web Proxy Server on page 39‖. 

 

Configuring Apache Web Server on Solaris 

This section shows how to configure an Apache Web Server 2.0.55 proxy for Agile PLM and Agile 
File Manager on Oracle Application Server 10g for Solaris. 

Apache Http Server 2.0.x for Solaris: 
http://archive.apache.org/dist/httpd/binaries/ 

Mod_Jk Connector for Apache 2.0: 
Download the connector from http://www.apache.org/dist/tomcat/tomcat-
connectors/jk/binaries/solaris/ or copy the mod_jk-1.2.15-sparc-Solaris8-Apache20.so file from 
the AGILE_HOME\AgileProxies directory. 

To configure Apache Web Server to be a Web proxy server for Agile PLM and Agile File 
Manager on Solaris: 

1.  Download, build, and install Apache Web Server for Solaris. For installation instructions, refer 
to the Apache documentation. 

./configure --prefix=/opt/apache2 -enable-mods-shared=all 

make 

make install 
 

2.  After installing Apache Web Server, install the proxy plug-in: 

a.  Go to the following directory: 

$Apache/modules/proxy 

b.  Run the following commands: 

$Apache/bin/apxs -i -a -c proxy_connect.c 
$Apache/bin/apxs -i -a -c proxy_http.c 

http://archive.apache.org/dist/httpd/binaries/
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/solaris/
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/solaris/
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3.  Download the Mod_Jk Tomcat Connector from the URL listed above or copy the mod_jk-
1.2.15-sparc-Solaris8-Apache20.so file from the AGILE_HOME\AgileProxies directory. Save 
the connector as $Apache/modules/mod_jk.so. 

4.  Create a Mod_Jk configuration file ($Apache/conf/workers.properties) with the following 
entries: 

worker.list=default 

worker.default.type=ajp13 

worker.default.host=<File Manager host name> 

worker.default.port=8009 

 

5.  Add the following lines to the $Apache/conf/httpd.conf file: 

#Enable Mod_proxy for Application Server Proxying 

LoadModule proxy_connect_module modules/mod_proxy_connect.so 

LoadModule proxy_http_module modules/mod_proxy_http.so 

#Enable Mod_Jk for File Manager proxying 

LoadModule jk_module modules/mod_jk.so 

 

# Add the proxy forward path.Replace appropriately with actual Virtual 

# path and server host/port 

ProxyPass /Agile http://server:7777/Agile 

ProxyPassReverse /Agile http://server:7777/Agile 

#Entries for File mgr proxying 

JkWorkersFile conf/workers.properties 

 

#Filemgr is virtual path for Agile File Manager 

JkMount /Filemgr default 

JkMount /Filemgr/* default 

 

6.  If mod_proxy was not compiled into httpd, add the following to the $Apache/conf/httpd.conf file: 

LoadModule proxy_module modules/mod_proxy.so 

 Open $Tomcat/conf/jk2.properties and add the following entry: channelSocket.port=8009 

   The AJP Port specified above must match the AJP port specified in $Tomcat/conf/server.xml. 

<Connector port="8009" 

  maxThreads="150" minSpareThreads="25" maxSpareThreads="75" 

  enableLookups="false" redirectPort="8443" debug="0" 

  protocol="AJP/1.3" /> 

http://server:7777/Agile
http://server:7777/Agile
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7.  Restart Apache Tomcat. 

8.  Restart Apache Web Server. 

$apache/bin/apachectl stop 

$apache/bin/apachectl start 
 

Configuring Apache Web Server on Linux 

This section shows how to configure an Apache Web Server 2.0.x proxy for Agile PLM and Agile 
File Manager on Oracle Application Server 10g for Linux. 

Generally, when you install Red Hat Linux it includes Apache Web Server 2.0 and the 
MOD_PROXY Connector. If your Linux server does not have Apache Web Server, you can 
download it from the following location: 

Apache Http Server 2.0.x for Linux: 
http://archive.apache.org/dist/httpd/binaries/ 

The Mod Jk Connector for Apache Http Server, which is necessary for using Apache as a proxy for 
Agile File Manager (Tomcat), can be installed using Red Hat RPM. You can also download the 
source from the following location and compile it. 

Mod_Jk Connector for Apache 2.0: 
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/linux/ or contact Agile Support. 

To configure Apache Web Server to be a Web proxy server for Agile PLM and Agile File 
Manager on Linux: 

1.  Open the Apache Web Server $Apache/conf/httpd.conf file and ensure that the following 
modules are uncommented: 

LoadModule proxy_module modules/mod_proxy.so 

LoadModule proxy_connect_module modules/mod_proxy_connect.so 

LoadModule proxy_http_module modules/mod_proxy_http.so 

2.  At the end of the $Apache/conf/httpd.conf file, add the following ProxyPass and 
ProxyPassReverse commands. Replace the hostname, port, and Agile virtual path with 
appropriate values for your server. 

ProxyPass /Agile http://server:7777/Agile 

ProxyPassReverse /Agile http://server:7777/Agile 

3.  Copy the workers.properties and uriworkermap.properties files from the 
AGILE_HOME/AgileProxies directory to the $Apache/conf directory. 

4.  Replace the following tokens in the workers.properties and uriworkermap.properties files: 

@FILE_SERVER_VIRTUAL_PATH@ = File Manager Virtual Path 

@FILE-SERVER-HOST@ = Tomcat hostname or IP address 

@AJP-PORT@ = Tomcat AJP Protocol port (This port can be found in 
Tomcat’s server.xml file) 

5.  Add the following lines to the $Apache/conf/httpd.conf file: 

http://archive.apache.org/dist/httpd/binaries/
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/linux/
http://server:7777/Agile
http://server:7777/Agile
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LoadModule jk_module modules/mod_jk-1.2.14-apache-2.0.54.so 

JkWorkersFile conf/workers.properties 

JkMount conf/uriworkermap.properties 

 

6.  Open $Tomcat/conf/jk2.properties and add the following entry: 

channelSocket.port=8009 

 

   The AJP Port specified above must match the AJP port specified in $Tomcat/conf/server.xml. 

<Connector port="8009" 

  maxThreads="150" minSpareThreads="25" maxSpareThreads="75" 

  enableLookups="false" redirectPort="8443" debug="0" 

  protocol="AJP/1.3" /> 

 

7.  Restart Apache Tomcat. 

8.  Restart Apache Web Server. 

$apache/bin/apachectl stop 

$apache/bin/apachectl start 
 

Configuring Apache Web Server on AIX 

This section describes how to configure Apache HTTP Server 2.0.x on AIX as a reverse proxy for 
Agile PLM with Oracle Application Server 10g and Agile File Manager with Apache Tomcat. 

Download the Apache HTTP Server 2.0.x distribution: 

Download the Apache Http Server 2.0.x  distribution: 
http://archive.apache.org/dist/httpd/ 

Alternatively, you may be able to find a pre-compiled version of the HTTP server for AIX here: 
http://archive.apache.org/dist/httpd/binaries/aix/ 

Download the Apache Tomcat connector module (mod_jk) for Apache 2.0.x: 
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/ 

Alternatively, you may be able to find a pre-compiled version of the connector for AIX here: 
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/aix/ 

To configure an Apache HTTP Server on AIX as a reverse proxy server for Agile PLM and 
Agile File Manager: 

1. Download and install (and if necessary, build) Apache HTTP Server for AIX. For instructions, 
refer to the documentation included in the Apache distribution. 

2. After installing Apache HTTP Server, install the proxy plug-in: 

a. Change to the following directory: 

$APACHE_HOME/modules/proxy 

http://archive.apache.org/dist/httpd/
http://archive.apache.org/dist/httpd/binaries/aix/
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/
http://www.apache.org/dist/tomcat/tomcat-connectors/jk/binaries/aix/
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b. Run the following commands: 

$APACHE_HOME/bin/apxs -i -a -c procy_connect.c 

$APACHE_HOME/bin/apxs -i -a -c procy_http.c 

3. Download (and if necessary, build) the Apache Tomcat connector (mod_jk) from the URL 
previously listed. Save the connector as $APACHE_HOME/modules/mod_jk.so. 

4. Create a configuration file ($APACHE_HOME/conf/workers.properties) for the Apache Tomcat 
connector with the following entries: 

worker.list=default 

worker.default.type=ajp13 

worker.default.host=<File Manager host name> 

worker.default.port=8009 

5. Add the following lines to the $APACHE_HOME/conf/httpd.conf file: 

#Enable Mod_proxy for Application Server Proxying 

LoadModule proxy_connect_module modules/mod_proxy_connect.so 

LoadModule proxy_http_module modules/mod_proxy_http.so 

#Enable Mod_Jk for File Manager proxying 

LoadModule jk_module modules/mod_jk.so 

#Add the proxy forward path.Replace appropriately with actual Virtual 

#path and server host/port 

ProxyPass /Agile http://<application server hostname>:7777/Agile 

ProxyPassReverse /Agile http://<application server 
hostname>:7777/Agile 

#Entries for File Mgr proxying 

JkWorkersFile conf/workers.properties 

#Filemge is the virtual path for Agile File Manager 

JkMount /Filemgr default 

JkMount /Filemgr/* default 

6. If mod_proxy was not compiled into httpd, add the folliwng line to the 
$APACHE_HOME/conf/httpd.conf file: 

LoadModule proxy_module modules/mod_proxy.so 

7. Edit the file $TOMCAT_HOME/conf/jk2.properties and add the following entry for the AJP port: 

channelSocket.port=8009 

 The AJP Port specified above must match the AJP port specified in 
$TOMCAT_HOME/conf/server.xml. 

<Connector port="8009" 

  maxThreads="150" minSpareThreads="25" maxSpareThreads="75" 

  enableLookups="false" redirectPort="8443" debug="0" 

  protocol="AJP/1.3" /> 
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8.  Restart Apache Tomcat. 

9.  Restart Apache HTTP Server. 

$APACHE_HOME/bin/apachectl stop 

$APACHE_HOME/bin/apachectl start 

 
 

Enabling Debugging Information for the Jakarta Tomcat 
Connector 

To troubleshoot problems with the Apache Web Server proxy for Agile File Manager, you can save 
debugging information for the Jakarta Tomcat Connector. 

To save debugging information for the Jakarta Tomcat Connector: 

1.  Open the $Apache/conf/httpd.conf, and add the following lines (after the JkMount setting): 

JkLogFile "logs/mod_jk.log" 

JkLogLevel debug 

 

2.  Save the file. 

3.  Restart Apache Web Server. 

4.  Open the log file and check for errors. 
 

Logging In to the Agile Web Client 

Open your browser and go to the following URL to test the Agile Web client setup:    

http://webserver_hostname:port/virtual_path/PLMServlet   

Note The URL is case-sensitive. The default virtual path is Agile. 

The login window for the Agile Web client appears in the browser.    

Troubleshooting the Agile Web Client 

This section provides the basics for troubleshooting the Agile Web client and Web server issues. 

Confirming Accessibility 

Confirm that the following connections are valid: 

 Ping the Agile Application Server computer to make sure it is accessible from the Agile Web 
components computer and that the specified port is available. 

 Make sure the IIS Web server is up and running on the specified ports, and that the specified 
DNS hostname is valid and registered for external accessibility by the Agile Web client 

http://webserver_hostname:port/virtual_path/PLMServlet
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browsers. 
 

URL Error Messages 

If you specify this URL in the browser and receive the message ―Page not found,‖ check the 
following: 

 Make sure that the IIS Web server is accessible. 

 Open the iisproxy.ini file and make sure the client virtual path name is the same as the login 
URL for the Agile Web client. 

 Make sure the Agile Viewer has started on the host computer. 

If the following error message appears: 

―Servlet tunneling to AgileViewerHost:5099 (IP=x.x.x.x) Connection state: ERROR‖ 

 Check to see if the Agile Viewer hostname specified during the installation is correct and the 
port number is available. The information on the Agile Viewer hostname and port number is 
specified in the web.xml file. 

 Make sure the Agile Viewer-specific ports are open from DMZ firewall to the internal firewall. 
 

Log Files (Disk Space) 

There are two log files for the Agile Web client:     

 OASproxy log 

 Web client log 

If all log files are on, disk space can fill quickly. You may need to clean up the log files or turn 
logging off. 

For the OASproxy.log file: 

1.  Locate the key, HKEY_LOCAL_MACHINE\SOFTWARE\ORACLE\IIS Proxy Adapter, in the Windows 
Registry Editor. 

2.  Add the log-level entry value in the right pane as debug. 

For the Agile Web client log file: 

1.  Open the \AGILE_HOME\agileDomain\config\log.xml file. 

2.  Change the <priority value="debug" /> line to <priority value="error" />. 

3.  Delete all files with a LOG extension appearing in the \AGILE_HOME\agileDomain\config 
folder. 

 

Connection Refused or Server is Busy Error Message 

TCP connections can be buffered in a wait queue, which has a default value of 50. To increase this 
value, open \AGILE_HOME\agileDomain\config\config.xml and increase the wait queue attribute 
value by 25 percent until the messages no longer appear. 
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Changing Logging Priority 

You can change the behavior of the information added to the log file for the Agile Web client. 

1.  Using a text editor, open the log.xml file (by default, it is located in 
\AGILE_HOME\agileDomain\config folder). 

2.  Scroll to the bottom of the file and add the following lines before the </configuration> line: 

<category name="com.agile"> 

  <priority value="error" /> 

  <appender-ref ref="A1" /> 

</category> 

3.  Save and close the file. 

4.  Open a browser and type the following in the Address field: 

http://hostname:port/virtual_path/PLMServlet?changeLog=true 

http://hostname:port/virtual_path/PLMServlet?changeLog=true
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Chapter 8 

Configuring the Microsoft Excel-based 
Client for Agile PG&C 

This chapter includes the following: 

 Overview of the Microsoft Excel-based Client for Agile PG&C ............................................................................ 57 
 Microsoft Excel-based Client FAQ ....................................................................................................................... 59 
 Configuration Sequence ...................................................................................................................................... 61 
 Setting Privileges for Agile PG&C Objects .......................................................................................................... 62 
 Enabling Attributes that are Required for Excel Rollups ...................................................................................... 63 
 Restricting the Length of Declaration Names ...................................................................................................... 64 
 Deploying License Files for the Agile PLM ActiveX Control ................................................................................ 65 
 Using the Developer Version of the Microsoft Excel Integration License File ..................................................... 66 
 Digitally Signing the Agile PLM ActiveX Control .................................................................................................. 66 
 Enabling Downloading of Productivity Components ............................................................................................ 67 
 Installing the Agile PLM ActiveX Control ............................................................................................................. 68 
 Testing the Microsoft Excel-based Client for Agile PG&C ................................................................................... 68 
 Troubleshooting ................................................................................................................................................... 70 

 
 

Overview of the Microsoft Excel-based Client for 
Agile PG&C 

Important Configuration steps described in this chapter apply only to customers who have purchased Agile 
Product Governance & Compliance. 

 

Agile Product Governance & Compliance (PG&C), one of the Agile PLM product solutions, is 
designed to help manufacturers audit the presence and amount of regulated substances used in 
their products, and to demonstrate that they responsibly dispose of, recycle, or reuse parts 
containing those substances. Agile PG&C includes built-in support for the Microsoft Excel-based 
client for OEM manufacturing regulations, including the Japan Green Procurement Survey 
Standardization Initiative (JGPSSI), and substances and weights rollups. 
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Important Although Agile provides two Microsoft Excel templates for Agile PG&C, the solution is 
extensible. You can develop other Microsoft Excel templates to handle other 
Declaration classes your company has defined. For information about how to develop 
Microsoft Excel templates for use with Agile PG&C, contact your Agile Solutions 
Delivery representative. 

Important After installing Agile PLM, if any of the changes detailed in this chapter are required 
for your Excel integration, the correct sequence is: (a) stop the application server(s); (b) 
undeploy; (c) make the changes in <standard Agile PLM Install folder> > application.ear; (d) 
re-deploy; and (e) re-start the servers. 

 

JGPSSI Support 

JGPSSI has created a standardized digital form that companies can use to inquire about the 
chemical substances contained in parts and materials they procure in Asia. For more information 
about JGPSSI, see the Japan Electronics and Information Technology Industries Association Web 
site: 

http://home.jeita.or.jp/eps/greenTOP-eg.html http://home.jeita.or.jp/eps/greenTOP-eg.html 

JGPSSI uses Microsoft Excel tools for collecting information about substances contained in 
assemblies for Japanese Green Procurement. Agile provides a flexible and reusable integration 
between Agile PG&C and Microsoft Excel that allows customers to use the JGPSSI spreadsheet 
without modification, and then upload the information to Agile PG&C after validation. 

Note Agile PLM supports the JGPSSI survey tool (a Microsoft Excel template) version 
2.02. 

Agile PLM supports a Japanese-language template of the JGPSSI spreadsheet. The 
Japanese-language templates are only available to customers who have purchased the 
Japanese Server License. Also, the administrator must set users’ Language and Encode 
user preferences to the appropriate setting to work in that language in the Agile clients’ 
user interfaces. Please contact Agile Solutions Delivery for more information. 

Substances and Weights Rollups 

You can use Microsoft Excel to perform analysis of the Bill of Substances (BOS) information for an 
assembly. Using the Actions menu command Rollup in Excel, the integrated Excel spreadsheet can 
roll up the substances and weights for the top-level assembly. 

Note Agile PLM supports a Japanese-language template of the Substances and Weights 
spreadsheet. 

PLM also supports localized versions in Chinese, French, and German of the Substances 
and Weights Rollup feature used in Microsoft Excel-base Client. However, the localized 
template does not work for these languages out-of-the-box, the template must be adjusted 
by Oracle Consulting-Agile Practice. 

The Japanese-language templates are only available to customers who have purchased 
the Japanese Server License. Localized versions also need appropriate License Key. Also, 
the administrator must set users’ Language and Encode user preferences to the 
appropriate setting to work in that language in the Agile clients’ user interfaces. Please 

http://home.jeita.or.jp/eps/greenTOP-eg.html
http://home.jeita.or.jp/eps/greenTOP-eg.html
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contact Oracle Consulting-Agile Practice for more information. 

Client Software Requirements 

The Microsoft Excel-based client for Agile PG&C requires the following client-side software: 

Operating System 

 Windows 2000 Pro SPX 

 Windows XP Pro SP2 

 Windows 2003 Pro SP1 
 

Client Applications 

 Microsoft Excel 2000, Microsoft Excel XP, or Microsoft Excel 2003 Pro SP1 

 Microsoft Internet Explorer 6.0 

For complete Agile PLM software requirements, see the Agile PLM Capacity Planning and 
Deployment Guide. 

Microsoft Excel-based Client FAQ 

This section answers some common questions about the Microsoft Excel-based client for Agile 
PG&C. 

How does the Microsoft Excel-based client work? What is the underlying technology used to integrate with 
Agile PG&C? 

The Microsoft Excel-based client uses the following technology: 

 Agile PLM Process Extensions – Agile Web Client launches the Microsoft Excel-based client 
through process extensions (PX), which are programs that extend the functionality of the client 
interface. 

 Agile PLM ActiveX Control – an Internet Explorer plugin that monitors use of the Microsoft Excel-
based client and downloads and uploads data from the Agile PLM server as requested by the 
client. 

 HTTP, HTTPS, or SMTP – standard protocols used to move data between the server and the client 

 Microsoft Excel – spreadsheet client with its own client-side business logic. 

Other than Microsoft Excel, is any other client software required for the Microsoft Excel-based client? 

The Agile PLM ActiveX Control, an Internet Explorer plugin, is required. It’s downloaded and 
installed automatically the first time a user launches the Microsoft Excel-based client from Agile 
Web Client. Of course, Internet Explorer 6.0 is also required, as well as a Windows operating 
system. 

What Microsoft Excel templates does Agile PG&C provide by default? 

There are two Excel applications provided out-of-the-box with Agile P&C: 
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 JGPSSI Declaration application – supports Japanese Green Procurement 

 Rollup In Excel application – calculates substances and weights rollups for top-level assemblies 

Can I create new Microsoft Excel templates for use with Agile PG&C? 

Yes, the solution is extensible. For information on how to develop Microsoft Excel templates for 
Agile PG&C, contact your Agile Solutions Delivery representative. 

Can I create Microsoft Excel templates for use with other Agile PLM solutions, such as Product Collaboration? 

No. Currently, only Declaration classes and their subclasses are supported. Other classes may be 
supported in future Agile PLM releases. 

Can I use the Firefox browser to launch the Microsoft Excel-based client? 

No. Only Microsoft Internet Explorer 6.0 is supported. 

Must I be logged into Agile Web Client to use the Microsoft Excel-based client for Agile PG&C? 

No. You can use the Microsoft Excel-based client synchronously (that is, by opening a spreadsheet 
from Agile Web Client) or asynchronously (that is, by opening a spreadsheet attached to an email 
message). 

How do I launch the Microsoft Excel-based client from Agile Web Client? 

Process extensions are used to launch the Microsoft Excel-based client. The process extension for 
launching JGPSSI-in-Excel is initiated from the Actions menu of JGPSSI declarations. The process 
extension for launching Substances and Weights rolllup in Excel is initiated from the Actions menu of 
items. For information about developing process extensions, see the Agile SDK Developer Guide. 

Can I sign the Agile PLM ActiveX Control with my company’s certificate? 

Yes. See ―Digitally Signing the Agile PLM ActiveX Control on page 66‖. 

Does the Microsoft Excel-based client require any special authentication? 

The Microsoft Excel-based Client uses the same credentials that you use to log into Agile Web 
Client, and it prompts you to log into a separate Agile PLM session when you choose Agile > Submit 
Response or Agile > Open Request. 

Where does the client-side business logic for the Microsoft Excel-based client reside? 

Client-side business logic resides entirely in the Microsoft Excel template. 

How does the Microsoft Excel-based client handle notifications for Declarations? 

Agile PLM provides four system-generated notifications related to the Microsoft Excel-based client: 

 Declaration Excel Submit Success Supplier Notification – notification sent to the supplier to confirm 
successful submission of a Declaration. 

 Declaration Excel Submit Import Failure – notification sent to the compliance manager or originator 
to inform him that the submitted Declaration failed to be processed on the server due to import 
problems. 

 Declaration Excel Submit Failure – notification sent to the compliance manager or originator to 
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inform him that the submitted Declaration failed to be processed on the server due to an 
exception. 

 Declaration Excel Submit Failure Supplier Notification – notification sent to the supplier to inform him 
that the Declaration failed to be submitted due to import errors. 

Each notification includes text for the subject and body of a message. The Agile PLM administrator 
can modify these notification messages. 

To customize these notifications, start the Agile Java Client and log in as an administrator user. 
Click the Admin tab, and choose System Settings > Notifications > Declaration Notifications. Microsoft 
Excel-based client notifications are listed under ―Declaration Miscellaneous Notifications.‖ 

For more information about Agile PLM notifications, see the Agile PLM Administrator Guide. 

What languages does the Microsoft Excel-based client support? 

The JGPSSI and Rollup in Excel standard templates support English only. Other templates can be 
developed to support other languages. 

Microsoft Excel-based client messages and captions support all languages supported by Agile PLM 
9.2.2.4. Additionally, the menus of Microsoft Excel templates can be customized for different 
languages. 

Does the Microsoft Excel-based client use VBA macros? 

The Microsoft Excel templates provided for Agile PG&C do not use VBA macros. Although you are 
not prevented from developing a Microsoft Excel template that uses VBA macros, antivirus software 
may prevent the macros from running, and you should set the security level in Microsoft Excel to at 
least Medium (choose Tools > Macro > Security). 

Configuration Sequence 

To enable support for the Microsoft Excel-based client for Agile PG&C, you must perform the 
following manual configuration steps after Agile PLM has been installed: 

1.  Set up privileges for Agile PG&C objects (such as Substances and Declarations). 

2.  Enable specific attributes in PG&C-related classes to ensure the Microsoft Excel-based client 
functions correctly. 

3.  Restrict Declaration names to 50 characters for every class that you are enabling the Microsoft 
Excel-based client. 

4.  Obtain a production license for the Agile PLM ActiveX Control from your Agile Account 
Executive and deploy the related files on the Agile Application Server. 

5.  Optionally, digitally sign the Agile PLM ActiveX Control. 

6.  Use Agile Java Client to set the Allow Download of Productivity Components preference to Yes. 
This allows Agile Web Client users to download the Agile PLM ActiveX Control from the server. 

7.  Install the Agile PLM ActiveX Control. 

8.  Test that the Microsoft Excel-based client for Agile PG&C works properly. 
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Setting Privileges for Agile PG&C Objects 

This section describes how to set privileges for Agile PG&C objects. If you don’t ensure that 
privileges are properly set, you may not be able to move data from the JGPSSI spreadsheet into 
Agile PLM and vice versa. 

To set privileges for Agile PG&C objects: 

1.  Log into Agile Java Client as a user with Administrator privileges. 

2.  Click the Admin tab. 

3.  Choose User Settings > Privileges. 

4.  Open the following privilege masks, and for each one click the drop-down arrow next to the 
Applied To field and add the following attributes: 

Privilege Mask Attributes to Add to the Applied To Field 

Read Substances Substances.Page Two.Text01 

Substances.Page Two.Text25 

 

Modify Substances 

Modify Supplier 
Created Declarations 

Declarations.Page Two.Text02, Text03, Text08 – 
Text10, Text14, Text19 – Text21 

Declarations.Items.Date01 

Declarations.Items.List01 - List03 

Declarations.Items.Text01 - Text09 

Declarations.Manufacturer Parts.Date01 

Declarations.Manufacturer Parts.List01 - List03 

Declarations.Manufacturer Parts.Text01 - Text09 

Declarations.Part Groups.Date01 

Declarations.Part Groups.List01 - List03 

Declarations.Part Groups.Text01 - Text09 

 

Read Declarations 

Read My Open and 
Submitted Declarations 

Read Supplier Created 
Declarations 

Modify Declarations 
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Privilege Mask Attributes to Add to the Applied To Field 

Modify My Open 
Declarations 

Declarations.Page Two.Text14, Text19 – Text21 

Declarations.Items.Date01 

Declarations.Items.List01 - List03 

Declarations.Items.Text01 - Text09 

Declarations.Manufacturer Parts.Date01 

Declarations.Manufacturer Parts.List01 - List03 

Declarations.Manufacturer Parts.Text01 - Text09 

Declarations.Part Groups.Date01 

Declarations.Part Groups.List01 - List03 

Declarations.Part Groups.Text01 - Text09 

 

5. After modifying the Applied To field for each of the privilege masks listed above, Click OK. 

6.  To save the privilege mask, click Save. 

7. Click Close. 

8.  Click Close. 
 

Enabling Attributes that are Required for Excel 
Rollups 

The following attributes must be enabled (Visible property is set to Yes for each attribute) at the 
class level for the Microsoft Excel-based client to function correctly. 

Classes: Parts, Manufacturer Parts, and Documents 

Compliance Tab > Composition Table 

 Specification Name 

 Declaration Name 

 Declared Weight 

 Supplier 
 

Compliance Tab > Substances Table 

 Child Level 

 Substance Name 

 Substance Type 
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 Mass 

 Declared PPM 

 CAS Number 

 Conversion Factor 
 

Classes: Parts and Documents 

BOM Tab 

 Item Number 

 Item Description 

 Item Rev (Item Revision) 

 Qty (Quantity) 
 

Manufacturers Tab 

 Mfr. Part Number 

 Mfr. Part Description 

 Mfr. Name 
 

Restricting the Length of Declaration Names 

Agile’s Microsoft Excel-based client requires Declaration names to not exceed 50 characters. If a 
Declaration has a name longer than 50 characters, you might not be able to open it in Microsoft 
Excel. 

To avoid potential problems opening Declarations with long names, you should restrict Declaration 
names to 50 characters for every class that you are enabling the Microsoft Excel-based client. You 
can do this by making autonumbers required (assuming that each number in the autonumber 
sequence does not exceed 50 characters) or by adjusting the maximum length of the Cover Page > 
Reference Number attribute. 

To make autonumbers required for a Declaration subclass: 

1.  Log into the Agile Java Client as an administrator. 

2.  Click the Admin tab. 

3.  Under Data Settings, double-click Classes. 

4.  Open a Declaration subclass that has enabled the Microsoft Excel-based client (for example, 
JGPSSI Declaration). 

5.  Select the General Information tab. 

6.  In the Autonumber Required list, select Yes. 

7.  In the Autogenerate list, select Yes. 
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8.  Click Save. 

To adjust the maximum length of Declaration names: 

1.  Log into the Agile Java Client as an administrator. 

2.  Click the Admin tab. 

3.  Under Data Settings, double-click Classes. 

4.  Open a Declaration class that has subclasses that have enabled the Microsoft Excel-based 
client (for example, JGPSSI Declarations). 

5.  Click the User Interface Tabs tab. 

6.  double-click Cover Page. 

7.  Click the Attributes: Cover Page tab. 

8.  double-click the Reference Number attribute. 

9.  Set the MaxLength property to 50 or less. 

10.  Click Save. 
 

Deploying License Files for the Agile PLM 
ActiveX Control 

To enable support for the Microsoft Excel-based client for Agile PG&C, you must obtain a valid 
license for the Agile PLM ActiveX Control, an Internet Explorer plugin. This license is specific to the 
server on which the Agile Application Server is installed. To obtain the license file (license.xml) and 
a properties file (properties.js), contact your Agile Account Executive. 

After you obtain the license file and properties file, you need to deploy the files on the Agile 
Application Server. 

Note If you have an application server cluster, you must deploy the Agile PLM ActiveX 
Control license files on the Respository Host server for Oracle Application Server or 
the Administration Server for WebLogic Server. The application server will then 
propagate the license files to other servers in the cluster. 

To deploy license files for the Agile PLM ActiveX Control: 

1.  Stop the Web proxy server. 

2.  Stop the Agile Application Server. 

3.  Windows: On the application server computer, open a command prompt window. 

UNIX: On the application server computer, open a terminal window and log on as the user who 
installed the Agile Application Server. 

4.  Expand the Agile application.ear file: 

Windows: \AGILE_HOME\install\bin\ExtractArchive.cmd 

UNIX: /AGILE_HOME/install/bin/ExtractArchive.sh 

5.  Copy the license.xml and properties.js files that you received from Agile to the following location: 
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\AGILE_HOME\agileDomain\applications\ExpandedEar\ExpandedWar\ambassador 

6.  Repack the Agile application.ear file: 

Windows: \AGILE_HOME\install\bin\RepackArchive.cmd 

UNIX: /AGILE_HOME/install/bin/RepackArchive.sh 

7. Undeploy the Agile application, and then redeploy it. 

Windows: 

\AGILE_HOME\agileDomain\bin\UnDeployAgilePLM.cmd 

\AGILE_HOME\agileDomain\bin\DeployAgilePLM.cmd 

UNIX: 

/AGILE_HOME/agileDomain/bin/UnDeployAgilePLM.sh 

/AGILE_HOME/agileDomain/bin/DeployAgilePLM.sh 

8. Start the Agile Application Server. 

9.  Start the Web proxy server. 
 

Using the Developer Version of the Microsoft 
Excel Integration License File 

If you are developing or testing Microsoft Excel templates for Agile PLM Declaration classes, you 
can use the developer version of the Microsoft Excel integration license file that is installed with the 
Agile PLM server. The developer license for the Agile PLM ActiveX Control provides the same 
functionality as the production license. However, when you install it, a warning message appears: 
―An UNTRUSTED web site is trying to use Agile PLM ActiveX Control to control your desktop.‖ Click 
Yes in the warning dialog box to continue installing the control. 

Digitally Signing the Agile PLM ActiveX Control 

The first time you choose one of the commands that launch the Microsoft Excel-based client (such 
as Actions > Open In Excel) in Agile Web Client, the Agile PLM ActiveX Control is automatically 
downloaded and installed on your computer. For security reasons, Internet Explorer requires that 
software it downloads must have a digital signature. A digital signature lets you verify the contents 
of a file and ensures that it comes from a trusted source. 

When you install Agile PLM, the Agile PLM ActiveX Control is already digitally signed from Agile 
Software. You can choose to use your company’s own digital signature for the control instead. If 
you use your company’s digital signature, each time a user of your Agile PLM system downloads 
the Agile PLM ActiveX Control it will be recognized as coming from your company and not from 
Agile Software. 

You provide a digital signature by purchasing a certificate from a certificate authority. A certificate 
authority is an entity that issues digital certificates for use by other parties. Examples of certificate 
authorities are Verisign  
(http://www.verisign.com/ http://www.verisign.com/) and CAcert (http://www.cacert.org/ 
http://www.cacert.org/). 

http://www.verisign.com/
http://www.verisign.com/
http://www.cacert.org/
http://www.cacert.org/
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For more information about digital signatures, go to the MSDN site (http://msdn.microsoft.com/ 
http://msdn.microsoft.com/) and search for ―Digitally Signing ActiveX Components‖. 

To digitally sign the Agile PLM ActiveX Control: 

1.  Stop the Web proxy server. 

2.  Stop the Agile Application Server. 

3.  Windows: On the application server computer, open a command prompt window. 

UNIX: On the application server computer, open a terminal window and log on as the user who 
installed the Agile Application Server. 

4.  Expand the Agile application.ear file 

Windows: \AGILE_HOME\install\bin\ExtractArchive.cmd 

UNIX: /AGILE_HOME/install/bin/ExtractArchive.sh 

5.  Digitally Sign the agileambassador.cab file found in the following location: 

\AGILE_HOME\agileDomain\applications\ExpandedEar\ExpandedWar\ambassador 

6.  Repack the Agile application.ear file 

Windows: \AGILE_HOME\install\bin\RepackArchive.cmd 

UNIX: /AGILE_HOME/install/bin/RepackArchive.sh 

7. Undeploy the Agile application, and then redeploy it. 

Windows: 

\AGILE_HOME\agileDomain\bin\UnDeployAgilePLM.cmd 

\AGILE_HOME\agileDomain\bin\DeployAgilePLM.cmd 

UNIX: 

/AGILE_HOME/agileDomain/bin/UnDeployAgilePLM.sh 

/AGILE_HOME/agileDomain/bin/DeployAgilePLM.sh 

8.  Start the Agile Application Server. 

9.  Start the Web proxy server. 
 

Enabling Downloading of Productivity 
Components 

The Agile PLM ActiveX Control is a plugin for Microsoft Internet Explorer that users can download to 
their client machines. To enable downloading of the Agile PLM ActiveX Control from the server, the 
Agile PLM administrator must log into the Agile Java Client and make sure the Agile PLM 
preference named Allow Download of Productivity Components is set to Yes. Otherwise, users won’t be 
able to download the ActiveX control and use the Microsoft Excel-based client. 

Note The Agile PLM ActiveX Control is supported only on the Microsoft Internet Explorer 
browser. You cannot use it with other browsers, such as Firefox. 

http://msdn.microsoft.com/
http://msdn.microsoft.com/
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To enable downloading of the Agile PLM ActiveX Control: 

1.  Log into Agile Java Client as a user with Administrator privileges. 

2.  Click the Admin tab. 

3.  Choose Server Settings > Preferences. 

4.  For the Allow Download of Productivity Components preference, select Yes. 

5.  Click Save. 

For more information about setting Agile PLM preferences, see the Agile PLM Administrator Guide. 

Installing the Agile PLM ActiveX Control 

If you enable downloading of the Agile PLM ActiveX Control (see the previous section), the plugin is 
installed automatically on the client computer when you choose a command (such as Actions > Open 
In Excel) that launches the Microsoft Excel-based client. Separate installation of the plugin is 
unnecessary. 

Some companies have strict security procedures that prohibit users from installing ActiveX controls 
automatically onto their desktop computers. If that is the case with your company, your IT 
department can install the Agile PLM ActiveX Control by downloading an installer for the plugin from 
the Agile Support site  
(http://support.agilesoft.com http://support.agile.com). 
 

Testing the Microsoft Excel-based Client for 
Agile PG&C 

This section describes how to test whether the Microsoft Excel-based client works properly. 

To test JGPSSI Declarations: 

1.  In Agile Web Client, choose Create > Declarations > JGPSSI Declarations. 

2.  Specify a supplier. Also, make sure the Continue Creation in Wizard box is checked. Click 
Continue. 

3.  In the Compliance Manager field, select a user who is a compliance manager. 

4.  In the Workflow field, select Default Declarations. Click Next. 

5.  On the Add Specifications page, click Next. 

6.  On the Add Items page, click Add to add an item. Type an existing item number and Click OK. 

7.  Click Finish. 

http://support.agilesoft.com/
http://support.agile.com/
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8.  Choose Actions > Open in Excel. After a moment, a Security Warning dialog box appears. 

 

9.  Make sure the Always trust content from Agile Software Corporation box is checked. Click Yes to 
install and run the Agile PLM ActiveX Control (also called Agile Ambassador). 

10.  After a moment, Microsoft Excel is launched and a file with the name declaration_number.xls 
is opened. You are prompted to save the file to a folder on your desktop called Agile 
Spreadsheet Files. Click Save. 

11.  Close Microsoft Excel and return to Agile Web Client. 

12.  For the new JGPSSI Declaration you created, click Next Status to open it to the supplier. 

13.  Select users to notify, and Click OK. 

14.  Click the Exit  button to log out. 

15.  Click Login. Log in as a contact user for the supplier associated with the JGPSSI Declaration. 

16.  Click the link to the JGPSSI Declaration to open it. 

17.  In the Navigation pane, click Open In Excel. 

18.  After a moment, Microsoft Excel is again launched and the same file as earlier is opened. You 
are prompted to save the file to a folder on your desktop called Agile Spreadsheet Files. You 
already saved it earlier, so click Cancel. 

19.  Fill in a one or more fields on the sheet. For example, change the value of the Parts Mass 
field. 

20.  Save the Microsoft Excel file. 

21. Choose Agile > Submit Response. You need to log in at this point. The Submit Response window 
appears. 

22. Type your approval password, and click Submit. 
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23. After your response is uploaded, a message box appears: ―The declaration has been submitted 
for processing. Updates may not be immediately visible in the Agile system.‖ Click OK. 

 

To test Substances and Weights Rollups: 

1.  In Agile Web Client, open a part that is a top-level assembly with multiple substances. 

2.  Choose Actions > Rollup in Excel. 

3.  Select the specification that is used for the composition, and Click OK. The Excel file with the 
same filename as the part number appears. 

4.  In the Excel file, choose Agile > Run Scenario. The rolled-up amounts for materials and 
substances used in the assembly are displayed. 

 
 

Troubleshooting 

This section provides solutions to problems you may encounter in configuring the Microsoft Excel-
based client for Agile PG&C. 

Import and Error Logs 

Import and error logs for the Microsoft Excel-based client can be found in the server's Temp folder. 

On Windows 2000/2003 servers, the Temp folder is usually found at 

C:\Documents and Settings\<current_logged_in_user>\Local Settings\Temp\AgileEITemp 

or 

C:\Winnt\Temp\AgileEITemp 

If you are unsure where to find the Temp folder, open a Command Prompt window and type the 
following command: 

cd %temp%\AgileEITemp 

On UNIX servers, the Temp directory is usually found at 

/var/tmp/AgileEITemp 

The most recent folder under AgileEITemp contains data and import or error logs of the last 
submission done in Excel 

Runtime error 

When you choose any command that launches the Microsoft Excel-based client (such as Actions > 
Open In Excel) in Agile Web Client, a Runtime Error window appears. 

Solution: 

The license files for the Agile PLM ActiveX Control, which are located on the Agile Application 
Server, are invalid. Please contact Agile Support to request new license files. Once you receive the 
files, you must deploy them on the application server. See ―Deploying License Files for the Agile 
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PLM ActiveX Control on page 65‖. 

This feature has not been enabled by the application administrator 

When you choose an Action that launches the Microsoft Excel-based client in Agile Web Client, the 
popup window reads, ―This feature has not been enabled by the application administrator.‖ 
Consequently, the Agile PLM ActiveX Control could not be downloaded. 

Solution: 

In the Agile Java Client, set the Agile PLM preference Allow Downloading of Productivity Components to 
Yes. See ―Enabling Downloading of Productivity Components on page 67‖. 

The page cannot be displayed 

When you choose an Action that launches the Microsoft Excel-based client in Agile Web Client, the 
popup window reads, ―The page cannot be displayed.‖ 

Solution: 

Make sure the Web proxy server is running. 

Instead of opening a Microsoft Excel file, Agile Web Client login page appears in another window 

When you choose an Action that launches the Microsoft Excel-based client in Agile Web Client, the 
Microsoft Excel file doesn’t appear and instead a new browser window opens with Agile Web Client 
login page. 

Solution: 

 Make sure Agile Web Client login page you’re using has the fully qualified domain name for the 
server in the URL. For example, if the fully qualified domain name of the server is 
―plm.mycompany.com‖, Agile Web Client login page URL should look like this: 

http://plm.mycompany.com/Agile/PLMServlet 

 Make sure the Agile PLM ActiveX Control license file (license.xml) uses a fully qualified domain 
name for the Agile Application Server. 

The Open In Excel pop-up window appears and then closes, but Microsoft Excel doesn’t launch 

When you choose an Action that launches the Microsoft Excel-based client in Agile Web Client, the 
Open In Excel pop-up window appears for a few seconds, and then it closes without launching 
Microsoft Excel. 

Solution: 

The Declaration you’re trying to open has a very long name. Choose Actions > Save As to save the 
Declaration with a name that is 50 characters or less. 

To avoid this problem, restrict Declaration names to 50 characters. See ―Restricting the Length of 

Declaration Names on page 64‖. 

The Actions menu does not include commands to launch the Microsoft Excel-based client 

When you open an Item in Agile Web Client, the Rollup in Excel command isn’t available on the 
Actions menu. When you open a JGPSSI Declaration in Agile Web Client, the Open In Excel, Import 

http://plm.mycompany.com/Agile/PLMServlet
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JGPSSI, and Export JGPSSI commands aren’t available on the Actions menu. 

Solution: 

The Agile PG&C process extensions have not been assigned to Agile PLM classes. The Agile 
PG&C process extensions are assigned automatically to classes when Agile PLM is installed, but 
perhaps the Administrator modified the classes and inadvertently unassigned the Agile PG&C 
process extensions. 

Here is how the Agile PG&C process extensions should be assigned: 

 The Rollup In Excel process extension must be manually assigned to the Items classes, that is, 
Parts and Documents. 

 The Open In Excel, Import JGPSSI, and Export JGPSSI process extensions should be automatically 
assigned to the JGPSSI Declarations class. Please verify that this was accomplished; if they 
did not load, it needs to be done manually. 

For information on how to assign process extensions to classes, see the Agile PLM Administrator 
Guide. 

The cell or chart you are trying to change is protected and therefore read-only 

When you open a JGPSSI Declaration in Microsoft Excel and try to edit one of the cells, you see the 
following error message: ―The cell or chart you are trying to change is protected and therefore read-
only. To modify a protected cell or chart, first remove protection using the Unprotect Sheet 
command (Tools menu, Protection submenu). You may be prompted for a password.‖ 

Solution: 

The colored cells of the JGPSSI template (such as headings) are protected and cannot be edited. 
You should edit only unshaded (white) cells. 

Microsoft VBScript runtime error 1B6: Object doesn't support this property or method 

When you choose any command that launches the Microsoft Excel-based client (such as Actions > 
Open in Excel) in Agile Web Client, an error message appears: ―Microsoft VBScript runtime error 
1B6: Object doesn't support this property or method.‖ 

Solution: 

Internet Explorer had problems downloading the digital certificate for the Agile PLM ActiveX Control. 
Click OK in the error message box to continue. 

The problem may be due to a comma in the Company field of the digital certificate. If there isn’t a 
comma in the Company field, you may need to update your Internet Explorer browser with the latest 
patch from Microsoft. 

You must restart your computer before the new settings will take effect 

When you choose any command that launches the Microsoft Excel-based client (such as Actions > 
Open in Excel) in Agile Web Client, a message box appears: ―You must restart your computer before 
the new settings will take effect. Do you want to restart your computer now?‖ 

Solution: 

You have a previous version of the Agile PLM ActiveX Control installed, and Microsoft Excel is 
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currently open, so the control cannot be updated. To install the new control, close Excel, and then 
click No in the message box (to not restart the computer). Choose Actions > Open in Excel again. 
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Chapter 9 

Configuring Agile Product Portfolio 
Management 

This chapter includes the following: 

 Overview .............................................................................................................................................................. 75 
 PPM Post Upgrade Utility .................................................................................................................................... 75 
 Running the PPM Post Upgrade Utility ................................................................................................................ 75 

 
 

Overview 

Agile Product Portfolio Management (PPM) gives you powerful capabilities to define, analyze, and 
manage all aspects of a project or program. In Agile PLM 9.2.2.4, some of the business rules have 
been changed. These changes impact the data you have already created because the 
computations were based on previous rules. During an upgrade from a previous version of PPM, 
data migration is necessary in order for the existing data to comply with the new business rules. 

To facility the data migration, a post upgrade utility has been developed. 

Note The PPM post upgrade utility is NOT supported on WebSphere Application Server. 

 

PPM Post Upgrade Utility 

The PPM Post Upgrade utility was developed to address the following changes in Agile PLM: 

 Identifies all resource pool assignments where actual hours are greater than zero and sets the 
actual hours value to zero. 

 Identifies the leaf tasks that have an incorrect percent complete value, corrects the value, and 
then correctly rolls up the value on the parent task. 

 Identifies the tasks where estimated dates should be corrected based on the new business 
rules: 

a. If one of the estimated dates for a leaf task is null, it will be automatically populated, based 
on the other estimated date, only if the other date is not null. 

b. The estimated date is rolled up to the parent task considering the schedule date of the 
child task, if the child's estimated date is null. 

 Identifies all tasks that have an incorrect value for Actual Time and corrects them. 
 

Running the PPM Post Upgrade Utility 

The utility is installed after you have upgraded your system to Agile PLM 9.2.2.4. The files are 
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located at AGILE_HOME/agileDomain/tools/922PPMPostUpgradeUtility.zip 

 This utility should be run on the machine where Agile PLM 9.2.2.4 is installed. 

To run the PPM Post Upgrade Utility: 

1. Unzip the utility files to a temporary directory. 

2. Change to the directory where you have unzipped the files and locate the upgrade.properties 
file. 

3. Edit the following entries in the upgrade.properties file to match your environment: 

Server Settings 

server.url URL of the Agile PLM 9.2.2.4 application 

The format is <protocol>://<machine_name>/<application_name>. 

On OAS, the protocol should be ormi. On WebLogic, the protocol should be t3. 

server.login.id Login ID of the Agile user who has PPM-related privileges to run the utility, typically the 
admin user. 

server.login.password Password of the Agile user. 

pe.weekend.days Weekends configured in the server. This value should be the same as the setting in the 
agile.properties files. 

Database Settings 

db.url JDBC this driver URL of the database. 

The format is jdbc.oracle:thin@<db_machine_name>:<port>:<instance_name> 

db.username Agile database username 

db.password Agile database password 

Application Server Settings 

agile.dir The parent directory where the library files for the Agile application are located. 

oc4j.dir Location of the Oracle Application Server, if installed. 

wls.dir Location of the BEA WebLogic Application Server, if installed.  

4. Verify that the Agile PLM 9.2.2.4 application is running. 

5. On a command line, make sure that the JAVA_HOME environment variable points to the 
location of the JDK. If it does not, set the value to the correct location. 

6. In the directory where you unzipped the utility files, run install.cmd to start the utility. 

Important If you configured the PPM Post Upgrade Utility in Agile PLM 9.2.2 and are upgrading 
to Agile PLM 9.2.2.4, run install upgrade-actualtime.cmd, NOT install.cmd to start the 
utility. 

7. Restart the Agile application server. 
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Chapter 10 

Installing and Configuring Agile Java 
Client 

This chapter includes the following: 

 Agile Java Client Requirements ........................................................................................................................... 77 
 Installing the Agile Java Client ............................................................................................................................. 77 
 Reconfiguring Java Client JNLP Files ................................................................................................................. 78 
 Opening Multiple Java Clients ............................................................................................................................. 80 
 Integrating Agile PLM with Oracle AutoVue 19.3.2 .............................................................................................. 81 

 
 

Agile Java Client Requirements 

All users need to install JRE 6.0 to use Agile Java Client. JRE 6.0 is available at: 

http://java.sun.com/javase/downloads/index.jsp http://java.sun.com/javase/downloads/index.jsp 

The server-side deployment files for Agile Java Client are installed with the Agile Application Server. 

Note The Agile PLM administrator must send users the URL to connect to the Agile Java 
Client. 

 

Installing the Agile Java Client 

To use the Agile Java Client, you must have the Java Runtime Environment (JRE) version 6 
installed on your client computer. Agile Java Client uses Java Web Start technology to download 
the software and keep it updated. 

To install the Agile Java Client: 

1.  Open your browser and type the following: 

http://<hostname>.<domain>:<port>/JavaClient/start.html 

For example, the URL might look something like this: 

http://plmserver.mycompany.com/JavaClient/start.html 

2.  Click Launch. 

Java Web Start proceeds to download Java Client files and install them on your computer. This 
may take a few minutes. 

3.  If a Security Warning dialog box appears, click Start. 

4.  If the Agile 9.2.2.4 Desktop Integration dialog box appears, click Yes to integrate the Agile Java 
Client with your desktop. 

http://java.sun.com/javase/downloads/index.jsp
http://java.sun.com/javase/downloads/index.jsp
http://plmserver.mycompany.com/JavaClient/start.html
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You are prompted to log in to the Agile server. 

5.  Enter your Agile PLM username and password, and then Click OK. 

The main Agile Java Client window opens. 

Running Agile Java Client 9.0 and Agile Java Client 9.2.2.4 on 
the Same Computer 

Agile Java Client 9.0 and Agile Java Client 9.2.2.4 require different versions of the Java Runtime 
Environment (JRE). Agile Java Client 9.0 requires JRE 1.4.2, whereas Agile Java Client 9.2.2.4 
requires JRE 6.0. 

If you have both JRE 1.4.2 and JRE 6.0 installed on the same computer, you need to configure the 
Agile 9.0 application in Java Web Start to disable JRE 6.0. Otherwise, you will experience 
problems. For example, you won’t be able to add files to the Attachments tab of an object. 

To force Agile Java Client 9.0 to use JRE 1.4.2: 

1.  Go to the directory where JRE 1.4.2 is installed (such as D:\Program Files\Java\j2re1.4.2_09), and 
open the javaws subfolder. 

2.  Run Java Web Start (javaws.exe). 

3.  Choose View > Downloaded Applications. 

4.  Select the Agile 9.0 application. 

5.  Choose File > Preferences. 

6.  Click the Java tab. 

7.  In the Platform Version column, select 1.6. Make sure the Enabled checkbox is unchecked. 

8.  Click OK. 
 

Reconfiguring Java Client JNLP Files 

When you install the Agile Application Server, the following two JNLP files are configured for the 
Agile Java Client. These files are embedded with the application.ear file and deployed with the 
application: 

 pcclient.jnlp 

 ext.jnlp 

A JNLP file is an XML document that describes a Java application to be launched by Java Web 
Start. Ordinarily, the JNLP files are configured correctly during installation of Agile PLM. However, if 
you have an application server cluster and are unable to start Java Client and download its classes, 
you may need to reconfigure the JNLP files to point to the right servers. 

Modifying the JNLP Files 

In the AGILE_HOME\install\bin folder, Agile provides two utilities for unpacking the JNLP files from 
the application.ear file and repacking them again after you’ve modified them: 
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Windows Scripts UNIX Scripts 

ExtractJNLPFiles.cmd ExtractJNLPFiles.sh 

RepackJNLPFiles.cmd RepackJNLPFiles.sh 

 

To extract and modify the Java Client JNLP files: 

1.  Stop the Web proxy server or load balancer. 

2.  Stop the Agile Application Server. 

3.  On the application server computer, open a command prompt window. 

4.  Run the ExtractJNLPFiles script to extract the JNLP files from the application.ear file. 

AGILE_HOME\install\bin\ExtractJNLPFiles 

5.  Open the pcclient.jnlp file in a text editor. The file is located in the 
AGILE_HOME\agileDomain\applications folder. 

6.  Find the following tags and edit the values listed below in blue: 

jnlp: 

<jnlp spec="1.0+" codebase="http://<proxy/loadbalancer>.<domain>:<port>/JavaClient"> 

serverURL: 

<argument>serverURL=<protocol>://<appserver/loadbalancer>.<domain>:<port>/ 

<appserver_virtual_path></argument> 

webserverName: 

<argument>webserverName=<proxy/loadbalancer>.<domain>:<port></argument> 

where 

 <protocol> is the protocol used by the application server. Enter ormi for Oracle Application 
Server. 

 <proxy/loadbalancer> is the Web proxy server hostname or the alias for the load balancer 

 <domain> is the fully qualified domain name 

 <port> is the Web proxy server port or virtual port for the load balancer. 

 <appserver_virtual_path> is the Agile Application Server virtual path. The default is ―Agile‖. 

7.  Save the file. 

8.  Open the ext.jnlp file in a text editor. The file is located in an OAS or WebLogic subfolder 
beneath the AGILE_HOME\agileDomain\applications folder. 

9.  Find the following tag and edit the values listed below in blue: 

jnlp: 

<jnlp spec="1.0+" codebase="http://<proxy/loadbalancer>.<domain>:<port>/JavaClient"> 

where 

 <proxy/loadbalancer> is the Web proxy server hostname or the alias for the load balancer 

 <domain> is the fully qualified domain name 
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 <port> is the Web proxy server port or virtual port for the load balancer. 

10.  Save the file. 

11.  Run the RepackJNLPFiles script to repack the JNLP files into the application.ear file. 

\AGILE_HOME\install\bin\RepackJNLPFiles 

12. Start the Agile Application Server. 

13. Start the Web proxy server or load balancer. 

 
 

Opening Multiple Java Clients 

If you wish to have the ability to open multiple Java Clients on one machine, perform the following 
steps before deploying Agile PLM 9.2.2.4 on your application server: 

 Back up the application.ear file before proceeding. 

1.  On the application server computer, open a command prompt window. 

2.  Run the ExtractJNLPFiles script to extract the JNLP files from the application.ear file. 

\AGILE_HOME\install\bin\ExtractJNLPFiles 

Important If you have an OAS cluster, extract the JNLP files only on the Repository Host Server. 
When you redeploy the Agile application, the updated JNLP files will be propagated to 
all servers in the cluster. 

3.  Open the pcclient.jnlp file in a text editor. The file is located in the 
AGILE_HOME\agileDomain\applications folder. 

4.  Find the following tag: 

application-desc main-class: 

<application-desc main-class="com.agile.ui.pcclient.PCClient"> 

5.  Add the following tag to this class: 

<argument>singleSession=no</argument> 

6.  Save the file. 

7.  Run the RepackJNLPFiles script to repack the JNLP files into the application.ear file. 

\AGILE_HOME\install\bin\RepackJNLPFiles 
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Chapter 11 

Integrating Agile PLM with Oracle AutoVue 
19.3.2 

This chapter includes the following: 

 Installing Oracle AutoVue 19.3.2 for Agile PLM ................................................................................................... 81 
 Configuring the AutoVue 19.3.2 Viewer Client Libraries with the Viewer Installer ............................................... 81 
 Configuring the AutoVue 19.3.2 Viewer Client Libraries Manually ...................................................................... 82 

 
 

Installing Oracle AutoVue 19.3.2 for Agile PLM 

To install Oracle AutoVue 19.3.2 for Agile PLM (Agile Viewer), you must first download the Oracle 
AutoVue 19.3 for Agile PLM media pack as described in "Obtaining Software from Oracle E-
delivery." Then, follow the instructions in the Oracle AutoVue for Agile PLM Installation and User 
Guide. 

If you are installing Oracle AutoVue 19.3.2 on Linux: 

1. Run the Red Hat Update Agent, up2date, to download the latest Xvfb and Mesa files. 

Note AutoVue Server installer does not detect whether Mesa or Xvfb are installed. 

2. Install Xvfb version 6.8.2 or later. 

Make sure you install Xvfb with XRender and GLX extensions. 

3. Install the latest Mesa package (recommended version is 6.5.2 or later). 

4. Install the libsane package, if not already installed. 

5. Install the libXp package, if not already installed. 

6. Install the Wine RPM package "wine-av-20040914-15.i386.rpm" from Oracle AutoVue Open 

Source Components http://oss.oracle.com/AutoVue.  

 If you have an older version of Wine, you will need to uninstall it and then install the 
package that is certified with AutoVue 19.3.1. 

 Install Wine as a root user by running the following command: 

#rpm -i wine-av-20040914-15.i386.rpm 

Note This version of Wine is installed at the /usr/av location. 

7. Follow the instructions in the Oracle AutoVue for Agile PLM Installation and User Guide to 
install AutoVue for Agile Version 19.3.2 on Linux. 

 

Configuring the AutoVue 19.3.2 Viewer Client Libraries with 
the Viewer Installer 

Follow the instructions in the Oracle AutoVue for Agile PLM Installation and User Guide to configure 

http://oss.oracle.com/AutoVue
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the Viewer client libraries. 

Note The following instructions are required ONLY if you are integrating Agile PLM on Solaris 
x86 with Oracle AutoVue 19.3.2. 

 
 

Configuring the AutoVue 19.3.2 Viewer Client Libraries 
Manually 

Gathering the Required AutoVue Binaries 

1. Copy the html folder from the AGILE_HOME\AVS directory on the Viewer system to a 
temporary location. 

2. Rename the folder to jVue. 

3. Copy the vueServlet.jar file from the AGILE_HOME\AVS\bin directory on the Viewer system to 
a temporary location.  

4. Copy the jVue.jar, jogl.jar, and gluegen-rt.jar files from the AGILE_HOME\AVS\html directory 
on the Viewer system to a temporary location. 

5. Copy the com folder from the AGILE_HOME\agileDomain\deployment\tomcat\applet on the 
system where the Agile Application Server is installed to the jVue folder previously created. 

 
 

Configuring the Agile Application Server 

1. Use the ExtractArchive utility, located in the AGILE_HOME\install directory, to unpack the 
AGILE_HOME\agileDomain\applications\application.ear file. 

2. Add the jVue folder, created in the previous section, to the ExpandedWar directory of the 
application.war file, located inside of the application.ear file. 

The path should be as follows: 
AGILE_HOME\agileDomain\applications\ExpandedEar\ExpandedWar. 

3. Add the vueservlet.jar, jVue.jar, jogl.jar, and gluegen-rt.jar files,copied in the previous section, 
to the  \WEB-INF\lib directory of the application.war file's ExpandedWar directory. 

4. Use the RepackArchive utility, located in the AGILE_HOME\install directory, to repack the 
application.ear file. 

5. Undeploy the Agile application from Oracle Application Server.  

To do this, follow these steps. 

a.  Make sure Oracle Application Server is still running. 

To check OAS status, open a command prompt window, change to ORACLE_HOME\opmn\bin 
directory, and run opmnctl status. If OAS isn’t running, run opmnctl startall. 

b.  From a command prompt window, change to the AGILE_HOME\agileDomain\bin directory. 

c. Run UnDeployAgilePLM <OC4JAdmin Password> to undeploy the Agile application. 

6. Open a Command Prompt window and change to the AGILE_HOME\agileDomain\bin directory. 
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7. Run DeployAgilePLM <OC4JAdmin Password> to deploy the Agile PLM application. 
 

Configuring the File Manager 

1. Stop the Tomcat Service. 

2. Delete the deployed folder of your file manager, located at AGILE_HOME\Tomcat\webapps. 
The name of this deployed folder is equivalent to the name of the Virtual Path entered for File 
Manager during installation. The default folder name is Filemgr. 

3. Add the jVue folder, created the previous section, to the webfs.war file, located at 
AGILE_HOME\agileDomain\applications. 

4. Add the vueServlet.jar, jVue.jar, jogl.jar, and gluegen-rt.jar files copied in the previous section 
to the \WEB-INF\lib directory, located inside the 
AGILE_HOME\agileDomain\application\webfs.war file. 

5. Set the Agile Viewer Host Name and Port Number in the web.xml file, located inside the 
AGILE_HOME\agileDomain\applications\webfs.war at the \WEB-INF\ path. 

 
<servlet-name>VueServlet</servlet-name> 

        <servlet-class>com.cimmetry.servlet.VueServlet</servlet-class> 

        <init-param> 

            <param-name>JVueServer</param-name> 

            <!--<param-value>hcmweb:5099</param-value>--> 

            <param-value>view_server_host_name:port</param-value> 

        </init-param> 

6. Start the File Manager. 

7. Check the VueServer Connection on the File Server Configuration page with the following URL: 
 http://<fileserver_host>:<port>/<fileserver_virtual_path>/Configuration 

Note Repeat the steps in this section on ALL File Managers. 
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Appendix A 

Agile PLM Service Pack Installation 

This Appendix includes the following: 

 Install and Test Notice ......................................................................................................................................... 85 
 Installing an Agile PLM Service Pack on Windows .............................................................................................. 85 
 Installing an Agile PLM Service Pack on UNIX .................................................................................................... 89 

 
 

Install and Test Notice 

Important Install and test this release on a designated development server before installing it on 
your production environment. Your development environment should mirror your 
production environment as closely as possible to provide accurate testing results. It is 
important to validate the installation of this release, and confirm your integrations are 
working correctly as part of your minimum due diligence. Any problems or questions 
noted during your development system testing should be resolved before installing this 
release on your production environment. 

 

Installing an Agile PLM Service Pack on 
Windows 

Upgrade Requirements 

Before you install an Agile PLM service pack, make sure your system meets the following 
requirements: 

Operating System 

 Windows 2003 SP1 and later 

Application Server 

 Oracle Application Server 10g (10.1.3.4.0) 

Agile PLM 9.2.2.7 runs on Oracle Application Server 10.1.3.4.0; which must be installed and 
running before Agile PLM 9.2.2.7 is installed. 

Oracle Application Server 10.1.3.4.0 is a patchset and must be installed over the base 10.1.3.x 
SOA Suite. A Patchset/Minipack is an electronic version of the software. To download the Product 
Patchset/Minipack, go to the Oracle MetaLink Web site (https:// metalink.oracle.com/) and search 
for the product. Refer to the Patchset/Minipack description and view the Readme. After you review 
the Readme, download the Product Patchset/Minipack. 
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There will be one zip file which contains all Product binaries, documentation, and database files. 
Follow the installation instructions from the Install Guide to install the product. 

Please see the complete Oracle Application Server installation documentation before installing the 
server. 

Supported Application Upgrade Path 

The Agile PLM application upgrade path is from the following release: 

 Agile PLM 9.2.2.4 and all supported hot fixes and service packs 

Installation Workaround 

Important If you are upgrading in a language other than English, you must perform the following 
workaround before installing the service pack. 

1. In the AGILE_HOME\Install\config folder, backup all the existing .cfg files (Examples: 
agile_app.cfg, agile_api.cfg, agile_dfm.cfg, agile_ws.cfg etc.). 

2. Manually add the following server configuration information in English to the head of the 
agile_app.cfg, agile_api.cfg, agile_dfm.cfg, agile_ws.cfg..etc files: 

 

Application Server Type=oas 

Application Server Host=@APP_SERVER_HOST_NAME@ 

Application Server Virtual Path=@APP_SERVER_VIRTUAL_PATH@ 

Clustered=@CLUSTER_INSTALLED@ 

OAS Home=@OAS_HOME@ 

OAS HTTP Listen Port=@OAS_LISTEN_PORT@ 

Web Server Host=@WEB_SERVER_HOST_NAME@ 

Web Server Port=@WEB_SERVER_PORT_NUMBER@ 

 
 

Upgrading the File Manager 

1. If there is no distributed file server network, stop here and go to Upgrading the Application 
Server. Otherwise, continue with the following steps. 

2. Stop the file server and Apache or IIS admin services. 

3. Back up the existing deployed application, Filemgr, if present: 

a. Change to the AGILE_HOME\Tomcat\webapps directory. 

b. Verify there is a directory named Filemgr under the webapps directory. 

c. If the Filemgr directory exists, then perform the following: 

cd .. 

mkdir webapps.old 

mv webapps\Filemgr webapps.old 

4. Download Agile922x_Win.exe to a temporary folder. 
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5. Download and extract the contents of the 9.2.2.x_Platforms.zip file to the same location as the 
Agile922x_Win.exe file. 

6. In the temporary file, double-click Agile922x_Win.exe. 

The Install Window appears. 

7. Click Done to finish the installation. 

Note If you are using AutoVue, see the AutoVue for Agile PLM documentation. 

8. Repeat the steps in this section on each distributed file server. 

9. Start Apache or IIS admin services, if configured. 
 

Upgrading the SDK Client 

1. If the SDK Client is installed on the same machine as the application server, stop here and go 
to Upgrading the Application Server. Otherwise, continue with the following steps. 

2. On the system where the SDK Client is installed, download Agile922x_Win.exe to a temporary 
folder. 

3. Download and extract the contents of the 9.2.2.x_Platforms.zip file to the same location as the 
Agile922x_Win.exe file. 

4. In the temporary folder, double-click Agile922x_Win.exe. 

The Install window appears. 

5. Click Done to finish the installation. 
 

Upgrading the Application Server 

1. Undeploy the Agile Application: 

a. Make sure Oracle Application Server is still running. 

To check OAS status, open a command prompt window, change to oracle_home\opmn\bin 
directory, and run opmnctl status. If OAS isn't running, run opmnctl startall. 

b. From a command prompt window, change to the AGILE_HOME\agileDomain\bin directory. 

c. Run UnDeployAgilePLM <OC4JAdmin Password>. 

d. From the same command prompt window, run cleanup <OC4JAdmin Password>. 

2. If you are upgrading the Agile Application in a cluster, undeploy the application on the Primary 
Server. The application is automatically undeployed on the secondary servers. 

3. Stop the OPMN processes from the Oracle home directory: 

a. Open a command prompt window. 

b. Stop the Oracle Application Server instance: 

\oracle_home\opmn\bin\opmnctl stopall 

4. Verify that the application server, the Apache or IIS Admin Service, and any additional Agile 
services are stopped. 

5. Upgrade the Oracle Application Server to version 10.1.3.4, if it has not already been upgraded. 
See Upgrade Requirements on page 85 for more information. 
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6. On the system where the application server is installed, download Agile922x_Win.exe to a 
temporary folder. 

7. Download and extract the contents of the 9.2.2.x_Platforms.zip file to the same location as the 
Agile922x_Win.exe file. 

8. In the temporary folder, double-click Agile922x_Win.exe. 

The Install window appears. 

 If you are upgrading the Agile Application in a cluster, install the application on all 
servers in the cluster. 

9. Click Done to finish the installation. 

Note If you are using AutoVue, see the AutoVue for Agile PLM documentation. 

10. Restart the Oracle Application Server instance: 

\oracle_home\opmn\bin\opmnctl startall 

11. Check the status of the Oracle Application Server instance: 

\oracle_home\opmn\bin\opmnctl status 

Note Make sure the database schema is compatible with Agile PLM 9.2.2.x before 
starting the application server. See the Database Upgrade Guide for the schema 
version. 

12. Deploy the Agile application: 

a. From a command prompt window, change to the \AGILE_HOME\agileDomain\bin directory 
and run configure <OC4JAdmin Password>. 

b.  From the same command prompt window, run DeployAgilePLM <OC4JAdmin Password>. 

When deployment is finished, the script prompts that the Agile application has been deployed. 

 If you are upgrading the Agile Application in a cluster, deploy the application on the 
Primary Server. The application is automatically deployed on the secondary servers. 

13. Check the default_group~home~default_group~1.log file in the following directory to verify that 
the Agile application is deployed: 

\oracle_home\opmn\logs\ 

14. Start the Apache or IIS Admin Service. 

 
 

Post-Installation Verification 

Application Server 

9.2.2.7: 

In the application menu under Help | About Agile, Update Versions should contain 9.2.2.7 and Agile 
Version should contain 9.2.2.7.14. 
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File Manager 

Start the File Manager before performing the following steps: 

1. Type http://<localhost:8080>/<fileserver_virtual_path>/Configuration to display the File 
Manager Configuration page. 

2. Confirm all lines show success. 
 

Installing an Agile PLM Service Pack on UNIX 

Upgrade Requirements 

Before you install an Agile PLM service pack, make sure your system meets the following 
requirements: 

Operating System 

 Solaris 9 or 10 

 Red Hat Linux 4 

 IBM AIX 5.3 

Supported Application Upgrade Path 

The Agile PLM application upgrade path is from the following release: 

 Agile PLM 9.2.2.4 and all supported hot fixes and service packs 

Installation Workaround 

Important If you are upgrading in a language other than English, you must perform the following 
workaround before installing the service pack. 

1. In the AGILE_HOME/Install/config folder, backup all the existing .cfg files (Examples: 
agile_app.cfg, agile_api.cfg, agile_dfm.cfg, agile_ws.cfg etc.). 

2. Manually add the following server configuration information in English to the head of the 
agile_app.cfg, agile_api.cfg, agile_dfm.cfg, agile_ws.cfg..etc files: 

 

Application Server Type=oas 

Application Server Host=@APP_SERVER_HOST_NAME@ 

Application Server Virtual Path=@APP_SERVER_VIRTUAL_PATH@ 

Clustered=@CLUSTER_INSTALLED@ 

OAS Home=@OAS_HOME@ 

OAS HTTP Listen Port=@OAS_LISTEN_PORT@ 

Web Server Host=@WEB_SERVER_HOST_NAME@ 
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Web Server Port=@WEB_SERVER_PORT_NUMBER@ 
 

Upgrading the File Manager 

1. If there is no distributed file server network, stop here and go to Upgrading the Application 
Server. Otherwise, continue with the following steps. 

2. Stop the file server and any additional Agile processes. 

3. Back up the existing deployed application, Filemgr, if present: 

a. Change to the AGILE_HOME/Tomcat/webapps directory. 

b. Verify there is a directory named Filemgr under the webapps directory. 

c. If the Filemgr directory exists, then perform the following: 

cd .. 

mkdir webapps.old 

mv webapps/Filemgr webapps.old 

4. Download the upgrade file to a temporary directory. 

Solaris (SPARC): Agile922x_Sol.bin 

Solaris (X86): Agile922x_Solx86.bin 

Linux: Agile922x_Lin.bin 

AIX: Agile922x_AIX.bin 

5. Download and extract the contents of the 9.2.2.x_Platforms.zip file to the same location as the 
upgrade file. 

6. From the temporary directory, run the upgrade file. 

The Install Window appears. 

7. Click Done to finish the installation. 

Note If you are using AutoVue, see the AutoVue for Agile PLM documentation. 

8. Repeat the steps in this section on each distributed file server. 
 

Upgrading the SDK Client 

1. If the SDK Client is installed on the same machine as the application server, stop here and go 
to Upgrading the Application Server. Otherwise, continue with the following steps. 

2. On the system where the SDK Client is installed, download the upgrade file to a temporary 
directory. 

Solaris (SPARC): Agile922x_Sol.bin 

Solaris (x86): Agile922x_Solx86.bin 

Linux: Agile922x_Lin.bin 

AIX: Agile922x_AIX.bin 

3. Download and extract the contents of the 9.2.2.x_Platforms.zip file to the same location as the 
upgrade file. 
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4. From the temporary directory, run the upgrade file. 

The Install window appears. 

5. Click Done to finish the installation. 
 

Upgrading the Application Server 

1. Undeploy the Agile Application: 

a. Make sure Oracle Application Server is still running. 

To check OAS status, open a terminal window, change to oracle_home/opmn/bin 
directory, and run opmnctl status. If OAS isn't running, run opmnctl startall. 

b. From a terminal window, change to the AGILE_HOME/agileDomain/bin directory. 

c. Run UnDeployAgilePLM.sh <OC4JAdmin Password>. 

d. From the same terminal window, run cleanup.sh <OC4JAdmin Password>. 

2. If you are upgrading the Agile Application in a cluster, undeploy the application on the Primary 
Server. The application is automatically undeployed on the secondary servers. 

3. Stop the OPMN processes from the Oracle home directory: 

a. Open a terminal window. 

b. Stop the Oracle Application Server instance: 

/oracle_home/opmn/bin/opmnctl stopall 

4. Verify that the application server, the Apache web server, and any additional Agile processes 
are stopped. 

5. On the system where the application server is installed, download the upgrade file to a 
temporary directory. 

Solaris (SPARC): Agile922x_Sol.bin 

Solaris (X86): Agile922x_Solx86.bin 

Linux: Agile922x_Lin.bin 

AIX: Agile922x_AIX.bin 

6. Download and extract the contents of the 9.2.2.x_Platforms.zip file to the same location as the 
upgrade file. 

7. From the temporary directory, run the upgrade file. 

The Install window appears. 

 If you are upgrading the Agile Application in a cluster, install the application on all 
servers in the cluster. 

8. Click Done to finish the installation. 

Note If you are using AutoVue, see the AutoVue for Agile PLM documentation. 

9. Restart the Oracle Application Server instance: 

/oracle_home/opmn/bin/opmnctl startall 

10. Check the status of the Oracle Application Server instance: 
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/oracle_home/opmn/bin/opmnctl status 

Note Make sure the database schema is compatible with Agile PLM 9.2.2.x before 
starting the application server. See the Database Upgrade Guide for the schema 
version. 

11. Deploy the Agile application: 

a. From a terminal window, change to the /AGILE_HOME/agileDomain/bin directory and run 
configure.sh <OC4JAdmin Password>. 

b. From the same terminal window, run DeployAgilePLM.sh <OC4Jadmin Password>. 

When deployment is finished, the script prompts that the Agile application has been deployed. 

 If you are upgrading the Agile Application in a cluster, deploy the application on the 
Primary Server. The application is automatically deployed on the secondary servers. 

12. Check the default_group~home~default_group~1.log file in the following directory to verify that 
the Agile application is deployed: 

/oracle_home/opmn/logs/ 

13. If the web server is installed on the same machine as the application server, restart the web 
server. 

14. If you are running in a clustered environment, repeat these steps on each application server. 
 

Post-Installation Verification 

Application Server 

9.2.2.7: 

In the application menu under Help | About Agile, Update Versions should contain 9.2.2.7 and Agile 
Version should contain 9.2.2.7.14. 

File Manager 

Start the File Manager before performing the following steps: 

1. Type http://<localhost:8080>/<fileserver_virtual_path>/Configuration to display the File 
Manager Configuration page. 

2. Confirm all lines show success. 
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Appendix B 

Agile PLM Installer Panels 

This Appendix includes the following: 

 Common Agile PLM Installer Panels ................................................................................................................... 93 
 Database Details Panel ....................................................................................................................................... 94 
 Application Server Panels .................................................................................................................................... 94 
 Web Server Panels .............................................................................................................................................. 96 
 Viewer Panels ...................................................................................................................................................... 97 
 File Manager Panels ............................................................................................................................................ 97 

 
 

Common Agile PLM Installer Panels 

The following Agile PLM installer panels are common to all components: 

Panel Step(s) to Perform 

Welcome Click Next. 

License Agreement Read the Agile PLM license agreement, and then select I accept the terms of the 
license agreement. 

Customer Information Enter your user name and company name. 

Choose Install Component(s) Select the components to install.  

When you select each component, a description of it appears in the Description box. 

Installation Mode Select Basic Mode (default) or Advanced Mode installation. Basic mode installs a 
standalone application server on Oracle Application Server only with minimal user 
input. Advanced Mode allows you to install a standalone or cluster system on Oracle 
Application Server or BEA WebLogic. 

Installation Location Enter the directory where you want to install Agile PLM components. This directory is 
also referred to as the Agile_Home. 

Choose Shortcut Folder Depending on your operating system, select where you would like to create links or 
product icons for Agile PLM. These shortcuts allow you to quickly launch Agile PLM 
programs. 

Windows users: To create Agile PLM icons for all users, make sure the Create 
Icons for All Users box is checked. 

Pre-Installation Summary Review the information you provided in previous panels to make sure it's correct 
before you install. 

If the information is correct, click Install. If you need to make any changes, click 
Previous to go to a previous panel. 
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Panel Step(s) to Perform 

Install Complete You have finished Agile PLM installation. 

Click Done to close the installer. 

Windows users: Depending on the components you installed, your computer may 
restart when you click Done. 

 
 

Database Details Panel 

The following Agile PLM installer panel appears to obtain database details: 

Panel Step(s) to Perform 

Agile PLM Database Details Enter your Agile PLM database information. If you do not know these values, see the 
database administrator responsible for your Agile PLM database server. 

Agile Database Host Name 

The fully qualified domain name of the computer where the Agile 
PLM database server is installed. 

Agile Database Port 

For Oracle, the default TNS Listener port is 1521. 

Agile Database SID 

Enter the Oracle System Identifier that refers to the instance of the 
Oracle database running on the server. The default SID is agile9. 

Agile Database User 

Enter the database user. The default user is agile. 

Agile Database User Password 

Enter the password for the Agile PLM database user. The default 
password is tartan. 

Note If your Agile PLM database is configured to use different 
values from the defaults listed above, specify that 
information instead. 

  
 

Application Server Panels 

The following Agile PLM installer panels appear when you install the Application Server: 

Panel Step(s) to Perform 
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Panel Step(s) to Perform 

Application Server Type Select the type of application server you are using. Agile PLM supports Oracle 
Application Server 10g (10.1.3.1.0) and BEA WebLogic Server 8.1 SP6. 

 The application server you select should be installed 
BEFORE you install Agile PLM. On Windows, you 
can install Oracle Application Server10g through the 
Agile PLM installer. 

Installation Type Select Standalone Installation or Cluster Installation. 

Note If you are installing Application Server and File Manager 
on the same computer, selecting Cluster Installation will 
cause both to be clustered.A standalone installation 
requires only a single server, and therefore may not be 
as scalable or as reliable. 

A cluster is a group of servers that work together to provide a more scalable, more 
reliable application platform than a single server. A cluster appears to its clients as a 
single server, but is actually a group of servers acting as one. A cluster can provide 
two key advantages over a single server: 

 Scalability: The capacity of a cluster is not limited to a single server or a single 
machine. New servers can be added to the cluster dynamically to increase 
capacity. If more hardware is needed, a new server on a new machine can be 
added. 

 High-Availability: A cluster uses the redundancy of multiple servers to insulate 
clients from failures. The same service can be provided on multiple servers in the 
cluster. If one server fails, the surviving members can continue to serve the 
application. The ability to fail over from a failed server to a functioning server 
increases the availability of the application to clients. 

Oracle Application Server Home Enter the directory where Oracle Application Server is installed, or where you plan to 
install it. This directory is also referred to as the Oracle Home. 

Important If you are installing an Oracle Application Server cluster, 
all servers in the cluster must use the same operating 
system. 

Oracle Application Server Information Enter details for your Oracle Application Server installation. 

AS Home Name 

Enter the OAS home name (not the directory location). 

AS Instance Name 

Enter the OracleAS 10g instance name (for example, oas). 

AS Admin Password 

Enter the password for the OracleAS 10g administration user, oc4jadmin. It must be 
at least five characters and it must contain one number. 

Note Enter the OC4JAdmin password specified during the installation of OAS. 
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Panel Step(s) to Perform 

Oracle Application Server 10g Setup 
Path 

Enter the path where the Oracle Application Server 10g installation program is 
located. Click Choose to browse to the path. 

Application Server Information Enter the Application Server information. 

Host Name 

Enter the fully qualified domain name of the Application Server. 

Clustered Application Server Type Choose the type of clustered Application Server 

 Primary Server 

 Secondary Server 

 Multicast Information Enter the multicast address and port number which are used as a part 
of the dynamic discovery mechanism for managing Oracle nodes in a 
cluster environment. 

 All of the nodes in the cluster topology must be configured to use the same 
multicast address and port number. 

 The multicast address must be within the valid address range from 224.0.1.0 to 
239.255.255.255. 

 
 

Web Server Panels 

The following Agile PLM installer panels appear when you install Agile Proxies: 

Panel Step(s) to Perform 

Apache Home Directory Enter the Apache Web Server home directory. 

You can click Choose to browse to the Apache home directory. 

Note If you are installing Agile PLM on Oracle Application 
Server (OAS), DON'T select the home directory for 
Oracle HTTP Server, a version of Apache Web Server 
that is included with OAS. 
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Panel Step(s) to Perform 

Web Server Information Enter information for the Web server used to proxy Agile PLM. If you are using a load 
balancer, specify the alias and virtual port for it instead. 

Host Name 

Enter the fully qualified domain name (for example, computer-
name.company.com) of the Web server. If you are using a load 
balancer, specify the alias for the load balancer virtual IP address. 

Port Number 

Enter the HTTP or HTTPS port used by the Web server. General 
Web access is typically available on port 80, but your deployment 
may use a different port. If you are using a load balancer, specify 
the virtual port number of the load balancer. 

 
 

Viewer Panels 

The following Agile PLM installer panel appears when you install the File Manager: 

Panel Step(s) to Perform 

Agile Viewer Enter Agile Viewer information. 

Host Name 

Enter the fully qualified domain name (for example, computer-
name.company.com) of the Viewer. 

Port Number 

Enter the port used by the Viewer. The default port is 5099, but your 
deployment may use a different port if 5099 is not available. 

 
 

File Manager Panels 

The following Agile PLM installer panels appear when you install File Manager: 

Panel Step(s) to Perform 

File Manager User Authentication A user account is used by the File Manager to communicate with the Application 
Server and its peers. You can use the default internal account or create a separate 
user account. 

Choose the type of user account you want to use for authentication. 
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Panel Step(s) to Perform 

File Manager User Account The File Manager user account is used by the File Manager to communicate with the 
Application Server and its peers. The default user account is ifsuser. 

File Manager User Name 

Enter the user account used to communicate with the Application 
Server (default:ifsuser). 

File Manager User Password 

Enter the File Manager user password (default:agile). 

File Manager Storage Location Enter the directory where the File Manager files are stored. Click Choose to browse 
to the path. 

Note Make sure the directory you specify is one to which you 
have write access. For clustered File Managers, you 
must specify a network location. 

File Manager Virtual Path Enter the virtual path used to connect to the Agile File Manager. The default virtual 
path is “Filemgr”, but you can change it to something appropriate for your company. 

The complete path for your Agile File Manager will be  
http://<web_server>:<port>/<file_manager_virtual_path>/AttachmentServlet. 

Important: The virtual path for Agile File Manager should be different from the virtual 
path for the Agile Application Server, especially if they use the same proxy server. 
The virtual paths should also have a different prefix. For example, if the Agile 
Application Server Virtual Path is “Agile”, the name of the Agile File Manager Virtual 
Path must start with something other than “Agile”. 

Agile File Manager Enter the machine name where File Manager is installed as well as the port number. 

Agile File Manager Host Name 

Enter the fully qualified domain name of the machine where you are 
installing the File Manager. 

Agile File Manager Port Number 

Enter the port number on which other Agile PLM applications will 
connect to the File Manager. The default port is 8080. 

If the File Manager is accessed through a proxy server or load balancer, enter the 
host name and port number of that machine. 

Application Server Virtual Path Enter the virtual path used to connect to the Agile Application Server. The default 
virtual path is “Agile”, but you can change it to something appropriate for your 
company. 

The complete path for your Agile Application Server will be  
http://<web_server>:<port>/<appserver_virtual_path>/PLMServlet. 

The virtual path for Agile Application Server should be different from the virtual path 
for the Agile File Manager, especially if they use the same proxy server. 
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Appendix C 

Agile Application Server Scripts 

This Appendix includes the following: 

 Installation and Configuration Scripts .................................................................................................................. 101 
 Application Scripts ............................................................................................................................................... 101 
 File Vault Utilities ................................................................................................................................................. 102 

 
 

Installation and Configuration Scripts 

Agile provides several scripts that can be used during installation and configuration of the Agile 
Application Server. The scripts are installed into the AGILE_HOME\install\bin directory: 

Windows Script UNIX Script Description 

ExtractArchive.cmd ExtractArchive.sh Extracts all of the files in the Agile application.ear file. 

ExtractConfigFiles.
cmd 

ExtractConfigFiles.s
h 

Extracts configuration files from the Agile application.ear file. 

ExtractJavaClient-
Files.cmd 

ExtractJavaClient-
Files.sh 

Extracts all of the Java Client files from the Agile application.ear file. 

ExtractJNLPFiles.c
md 

ExtractJNLPFiles.sh Extracts JNLP files for Java Client from the Agile application.ear file. 

A JNLP file is an XML document that describes a Java application to be 
launched by Java Web Start. To successfully download and install Java Client 
using Java Web Start, you must configure the JNLP MIME type for your server. 

RepackArchive.cmd RepackArchive.sh Repacks all of the files into the Agile application.ear file. After you run this script, 
you are ready to redeploy the Agile application. 

RepackConfigFiles.
cmd 

RepackConfigFiles.s
h 

Repacks configuration files into the Agile application.ear file. After you run this 
script, you are ready to redeploy the Agile application. 

RepackJavaClient-
Files.cmd 

RepackJavaClient-
Files.sh 

Repacks all Java Client files into JavaClient.war, and then updates the 
JavaClient.war file contained in the Agile application.ear file. After you run this 
script, you are ready to redeploy the Agile application. 

RepackJNLPFiles.c
md 

RepackJNLPFiles.sh Repacks JNLP files for Java Client into the Agile application.ear file. After you 
run this script, you are ready to redeploy the Agile application. 

 
 

Application Scripts 

Agile provides several scripts for deploying and starting the Agile application. The scripts are 
installed into the AGILE_HOME\agileDomain\bin directory: 
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Windows Script UNIX Script Description 

checkLDAPConfig.c
md 

checkLDAPConfig.s
h 

Tries to connect to the Directory Server and verify whether LDAP configuration is 
correct. 

DeployAgilePLM.c
md 

DeployAgilePLM.sh Deploys the Agile application on Oracle Application Server 10g. 

encryptpwd.cmd encryptpwd.sh Encrypts a password. 

configure.cmd configure.sh Configures the Agile application-related JMS settings. 

migrateUsersToDB.
cmd 

migrateUsersToDB.s
h 

Migrates users from the Directory Server to the Agile PLM database. After you 
run this script, make sure to restart your application server. 

setEnv.cmd setEnv.sh Sets common environment variables used to run other Agile scripts. 

cleanup.cmd cleanup.sh Removes the Agile application-related JMS settings. 

UnDeployAgilePLM.
cmd 

UnDeployAgilePLM.
sh 

Undeploys the Agile application on Oracle Application Server 10g. 

 
 

File Vault Utilities 

Agile provides several utilities to use with the File Vault. The utilities are installed in the 
AGILE_HOME\agileDomain\tools directory. 

iFSReorgV2 

Used to restructure the file vault during an upgrade from a version prior to Agile PLM 9.2.1. 

Usage: java -jar iFSReorgV2.jar -basedir <value> -oldFilePrefix <value> [-newFilePrefix <value>] [-logging 
<true/false>] [-simulate <true/false>] 

where 

 basedir is the file vault location to be reorganized 

 oldFilePrefix is the old file name prefix for the existing files in the vault 

 newFilePrefix is the new file name prefix. All of the existing files will be renamed with this prefix. 
This is an optional argument. If it is not specified, the old file name prefix is used. 

 logging enables logging of warnings or errors if set to true. The log is saved to a file named 
ifsReorg.log. 

 simulate simulates the reorganization process without actually moving or renaming the files. 

 
 

MetaFilesRemover 

Used to periodically remove metafiles from the file vault based on the last used date or size. This 
utility should be used when upgrading the Agile Viewer.  
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Note A user-created .cmf  file should not be listed or removed from the file vault. 

Usage: java -jar MetaFilesRemover.jar [-delete <value>] [-age <value>] [-size <value>] -basedir <value> -
prefix <value> -serverURL <value> -username <value> -password <value> 

where 

 delete deletes the metafiles. 

 age specifies the last access time (day). 

 size specifies file size (KB). 

 basedir is the file vault location where the metafiles are removed. 

 prefix is the file name prefix. 

 serverURL is the location of the DMS service, for example, 
http://server.company.com:80/Agile/services/DmsService. 

 username is the DMS service username. 

 password is the DMS service password. 

 
 

MetaItemGenerator 

Used to generate new metafiles for a file vault and should be used when upgrading Agile PLM or 
the Agile Viewer. The utility simulates offline metafile generation from all of the files in the vault and 
supports the primary file server, but not structured files. 

Usage: java -jar MetaItem.jar  -basedir <value> -filePrefix <value> -serverURL <value> -defaultUser <value> -
defaultPassword <value> [-logging <true/false>] 

where 

 basedir is the file vault location where the metafiles are generated. 

 filePrefix is the file prefix of the files in the vault. 

 serverURL is the URL of the server where the metafiles are persisted. 

 defaultUser is the default userid of the Agile system. 

 defaultPassword is the password of the default Agile user. 

 logging enables logging. All information is saved in the metaItem.log file. By default, logging is 
disabled.  

 
 

metaUtility 

Displays the number of files in the meta generation queue through a graphical user interface. 

http://server.company.com/Agile/services/DmsService
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Usage: java -jar metaUtility.jar  

VaultSimulation 

Used to create a virtual vault from a database. 

Usage: java -jar VaultSimulation.jar -VaultLoc <value> -URL <value> -userid <value> -password <value> [-
prefix <value>] 

where 

 VaultLoc is the file vault location. 

 URL is the database location. 

 userid is the database userid. 

 password is the database password. 

 prefix is the file name prefix. The default is Agile. 
 

DeadFilesLocator 

Used to locate dead files, including markups, in a file vault and shows how many files are missing in 
a specific distributed file management server. Dead files are automatically moved from the file vault 
to an archive folder. 

Usage: java -jar DeadFilesLocator.jar  -attachmentPrefix <value> -vaultRoot <value> [-moveProblemFiles 
<Y/N>] [-archiveFileDest <value>] [-db_url <value>] [-db_user <value>] [-db_password <value>] [-file 
<value>] [-VERBOSE <true/false>] 

where 

 attachmentPrefix is the file name prefix.  

 vaultRoot is the absolute path of the vault root. 

 moveProblemFiles determines the action for the dead files. 

 archiveFileDest is the fully qualified path to an existing directory where you want to move the 
dead files. 

 db_url is the URL of the database. 

 db_user is the name of the database user. 

 db_password is the password of the database user. 

 file is the absolute path to the agile.properties file. 

 
 

MissingFilesLocator 

Used to locate missing files, including redlined files, in a file vault, but not limited to a specific 
distributed file management server. 
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Usage: java -jar MissingFilesLocator.jar  -dburl <value> -dbuserid <value> -dbpassword <value> -ifsuser 
<value> -ifspassword <value> [-force <value>] 

where 

 dburl is the URL of the database. 

 dbuserid is the name of the database user. 

 dbpassword is the password of the database user. 

 ifsuser is the name of the file vault user 

 ifspassword is the password of the ifs user. 

 force forces the utility to continue even if the file server is offline. 
 

FixFileSize 

Corrects the file sizes in the database. The file size is determined based on the actual files in the 
vault, then corrects the size in the database. If the file size equals zero during an upgrade, the file 
size is returned to its original value after running this utility. 

Usage: java -jar FixFileSizeUtility.jar  -dburl <value> -dbuserid <value> -dbpassword <value> -ifsuser 
<value> -ifspassword <value> [-log] 

where. 

 dburl is the URL of the database. 

 dbuserid is the name of the database user. 

 dbpassword is the password of the database user. 

 ifsuser is the name of the file system user. 

 ifspassword is the password of the file system user. 
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Appendix D 

Agile System Maintenance 

This Appendix includes the following: 

 Using the Server as a Client ................................................................................................................................ 107 
 Performance Tuning ............................................................................................................................................ 107 
 Configuring Access to Objects using Agile Administrative Settings .................................................................... 109 
 Color Settings ...................................................................................................................................................... 110 
 Dynamic Versus Static IP Addresses .................................................................................................................. 110 
 Checking Your TCP/IP Connection ..................................................................................................................... 110 
 Configuring Browsers on Client Computers ......................................................................................................... 110 
 Uninstalling Agile PLM ......................................................................................................................................... 111 

 
 

Using the Server as a Client 

After installation, test Agile PLM on the server to make sure that client systems can start Agile 
products. You may also need to test Agile administration modifications as well. For best results, 
apart from this testing, do not use the Agile PLM server to perform data-related tasks such as 
creating and modifying Items and Changes. 

Performance Tuning 

This section provides some information on how to tune the application server to improve the 
performance of Agile PLM. 

Tuning JVM Parameters 

Oracle Application Server Containers for J2EE (OC4J) is a Java process that requires a Java virtual 
machine (JVM) to run. You can fine-tune your system’s JVM settings to improve memory 
management and garbage collection. 

JVM settings for OC4J are contained in the oracle_home\opmn\conf\opmn.xml file. To find JVM 
settings, look for the following lines in that file: 

<ias-component id="OC4J"> 

  <process-type id="home" module-id="OC4J" status="enabled"> 

    <module-data> 

      <category id="start-parameters"> 

          <data id="java-options" value="<enter JVM settings here>"/> 

Important If you modify the opmn.xml file, you must restart Oracle Application Server. 

The following table provides recommended JVM settings for the Agile Application Server: 
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Parameter Description Windows UNIX Comments 

Xms Minimum Heap Size 1024m 1024m The Minimum and Maximum Heap Sizes should be 
set to the same value. On Windows, the maximum 
value that can be safely set is 1536m. On UNIX, 
there is often a higher limit, but the typical 
recommendation is to have the heap sized at 
2048m. 

Xmx Maximum Heap Size 1024m 1024m  

XX:MaxPermSiz
e 

Maximum space for 
permanent objects 

256m 256m  

XX:NewSize Initial memory size for 
new objects 

256m 256m  

XX:MaxNewSize Maximum memory size 
for new objects 

256m 256m  

VMType Hotspot or server hotspot server On Windows, -hotspot option gives the best 
results. On UNIX, -server option gives the best 
results 

 

Note The Agile PLM installer adjusts JVM parameters to the following values if available 
physical memory of the machine exceeds 1.5Gb: 

-Xms1024m -Xmx1024m -XX:MaxPermSize=256m -XX:NewSize=256m -XX:MaxNewSize=256m 

For more information about how to tune JVM settings for OC4J, see the Oracle Application Server 
Performance Guide. Also see ―Performance Documentation for the Java Hotspot VM‖ available at 
the Sun Developer Network: http://java.sun.com/docs/hotspot/index.html 

Tuning Oracle HTTP Server 

This section describes how to tune Oracle HTTP Server to improve Agile PLM performance. The 
main configuration file for Oracle HTTP Server is httpd.conf. It is located in the following directory: 

Windows: oracle_home\Apache\Apache\conf 

UNIX: oracle_home/Apache/Apache/conf 

Open the httpd.conf file to edit it. You can use any text editor. 

In the httpd.conf file, search for the following parameters: ThreadsPerChild and MaxClients. The Oracle 
HTTP Server MaxClients directive limits the number of clients that can simultaneously connect to 
your web server, and thus the number of httpd processes. On Windows, the analogous parameter is 
ThreadsPerChild. 

The recommended settings are shown below: 

http://java.sun.com/docs/hotspot/index.html
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# Number of concurrent threads (i.e., requests) the server will allow. 

# Set this value according to the responsiveness of the server (more 

# requests active at once means they're all handled more slowly) and 

# the amount of system resources you'll allow the server to consume. 

# 

ThreadsPerChild 25 (for every 2 CPUs on the Application Server - Windows 
only) 

# 

# Limit on total number of servers running, i.e., limit on the number 

# of clients who can simultaneously connect --- if this limit is ever 

# reached, clients will be LOCKED OUT, so it should NOT BE SET TOO LOW. 

# It is intended mainly as a brake to keep a runaway server from taking 

# the system with it as it spirals down... 

# 

MaxClients 250 (for every 2 CPUs on the Application Server - UNIX only) 

Important If you modify the httpd.conf file, you must restart Oracle Application Server. 

 

Configuring Access to Objects using Agile 
Administrative Settings 

Access to Agile objects is controlled through the roles and privileges you grant users using the Agile 
web client administrative settings. Before allowing any external access to your Agile servers, you 
must first consider who needs access and what they need to access.         

The list of potential external users may include, but is not limited to: 

 Contract manufacturers 

 Suppliers 

 Customers 

 Licensees 

 Remote manufacturing facilities 

 Field service personnel 

 Traveling employees 

Allowing access to third-party companies, such as contract manufacturers, may require special 
consideration. Most likely, you do not want these users to have access to all of your product 
information. Instead, you may want to grant them access to only a small subset of your data. For 
instance, they may need access only to data about products that they build for you. 

Agile recommends that you create a role using the Agile Java client administrative settings for each 
different type of external user. Once the role is defined, users can be assigned to the role. All users 
assigned to the role will inherit the privileges that are assigned to the role. 

The Agile Web client administrative settings includes with a role called Example - Subcontractor 
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that can be used as a template for setting up access for external users. For more information, see 
the Agile Administrator Guide. 

You can take this one step further, and create a Page Two field on all Items and Changes called 
External User. This field can be filled with any external usernames that are allowed to access each 
Item or Change. A privilege can then be created for each role that allows access only to objects 
based on the value of this field. For instance, privileges can be created and granted so that Acme 
CEM employees can read only objects that have the value Acme in the External User field. 

Configuring Your Firewall 

Most likely, your Agile servers are located behind your corporate firewall. An important part of 
system security is allowing incoming connections from the Agile web client to Agile Application 
Server and Agile Viewer, while restricting access to other parts of your system.        

Color Settings 

For best support of the current Agile PLM color-coded user interface, set client computers to display 
more than 256 colors.          

Dynamic Versus Static IP Addresses 

You can use dynamic IP addresses with ―long-term lease‖ assignments, as well as static addresses, 
for Oracle systems. For best results, do not change the hostname of computers in the system, and 
use static addresses for all servers.         

Checking Your TCP/IP Connection 

To verify that the client computer has a TCP/IP connection to the Web server: 

1.  Open a Command Prompt window. 

2.  In the Command Prompt window, ping the Web server by typing: 

ping servername    
 

The system returns a statement similar to the following: 

Pinging server_name [10.1.1.160] with 32 bytes of data: 
Reply from 10.1.1.160: bytes=32 time =1ms TTL=128     
 

This response verifies that your TCP/IP connection is working. 

Configuring Browsers on Client Computers 

Agile recommends that all browsers are set to check for newer versions of stored pages every visit 
to the page. 
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To set Internet Explorer to check for newer versions of stored pages every visit to the page: 

1.  Open Start > Settings > Control Panel > Internet Options. 

2.  On the General tab of the Internet Properties dialog box, click Settings in the Temporary Internet 
files section. 

3.  Select Check for newer versions of stored pages: Every visit to the page, then Click OK. 

4.  Click OK to close the Properties dialog box. 
 

Uninstalling Agile PLM 

Follow these instructions to remove Agile PLM 9.2.2.4. 

To remove Agile PLM 9.2.2.4 on Windows: 

1.  Stop the following services: 

 IIS Admin Service 

 World Wide Web Publishing Service 

 Tomcat 

2. Uninstall Tomcat, if applicable. 

3. Undeploy the Agile application from Oracle Application Server.  

To do this, follow these steps. 

a.  Make sure Oracle Application Server is still running. 

To check OAS status, open a command prompt window, change to <OAS_Home>\opmn\bin 
directory, and run opmnctl status. If OAS isn’t running, run opmnctl startall. 

b.  From a command prompt window, change to the AGILE_HOME\agileDomain\bin directory. 

Note If you are undeploying the Agile applicaton from a cluster, run the following 
commands on the primary server. The application is automatically undeployed 
from the secondary servers. 

c. Run UnDeployAgilePLM <OC4JAdmin Password> to undeploy the Agile application. 

d. Run cleanup <OC4Jadmin Password> to remove all Agile-related JMS settings. 

4.  Choose Start > All Programs > Agile > Agile 9.2.2.4 > Uninstall Agile 9.2.2.4. 

5.  Click Uninstall on the Uninstall Agile window. 

6.  Click Done when finished. 

7.  Restart the computer. 
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Appendix E 

Tuning Memory for Java Applets 

This Appendix includes the following: 

 Java Control Panel .............................................................................................................................................. 114 
 Frequently Asked Questions ................................................................................................................................ 114 

The Agile Web Client uses Java applets for advanced functionality. Examples include the Gantt 
Chart and the Agile Viewer. These applets use the Java Plug-in to run inside your browser. 

The amount of memory an applet requires depends on the content it attempts to load. If you 
experience memory problems while running the Gantt Chart, the Agile Viewer, or other Java 
applets, you should increase the amount of memory available to Java applets. To configure Java 
applet runtime parameters, use the Java Control Panel. 

To adjust Java applet runtime parameters on Windows: 

1.  From the Windows Control Panel, run Java to open the Java Control Panel. 

2.  Click the Java tab. 

3.  In the Java Applet Runtime Settings box, click View. The Java Runtime Settings dialog box 
appears. 

4.  In the Java Runtime Parameters box, add the following: 

-Xmx<memory-limit> 

For example, to set maximum available memory to 256Mb, enter -Xmx256M. 

5.  Click OK to close the Java Runtime Settings dialog box. 

6.  Click OK to close the Java Control Panel. 

7.  Restart the browser. 

To adjust Java applet runtime parameters on UNIX: 

1.  Determine which version of the Java Plug-in the browser is using. 

2.  Run the script <java-dir>/jre/bin/ControlPanel to open the Java Control Panel. 

3.  Click the Java tab. 

4.  In the Java Applet Runtime Settings box, click View. The Java Runtime Settings dialog box 
appears. 

5.  In the Java Runtime Parameters box, add the following: 

-Xmx<memory-limit> 

For example, to set maximum available memory to 256Mb, enter -Xmx256M. 

6.  Click OK to close the Java Runtime Settings dialog box. 

7.  Click OK to close the Java Control Panel. 

8.  Restart the browser. 
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To adjust Java applet runtime parameters on Mac OS X: 

1.  Determine which version of the Java Plug-in the browser is using. 

2.  In Finder, run the Applications > Utilities > Java > Java <java-version> > Plugin Settings command. 

3.  In the Java Runtime Parameters box, add the following: 

-Xmx<memory-limit> 

For example, to set maximum available memory to 256Mb, enter -Xmx256M. 

4.  Click Apply. 

5.  Close the control panel, and restart the browser. 

 
 

Java Control Panel 

For more information about the Java Control Panel and how to configure Java runtime settings on 
your client computer, go to http://java.sun.com http://java.sun.com and search for ―Java Control 
Panel‖. 

Frequently Asked Questions 

How much physical available memory do I need to run Agile PLM applets? 
Please see the Agile PLM Capacity Planning and Deployment Guide for all Agile PLM hardware 
and software requirements. 

In general, you will need at least 256Mb free available memory to use for Java applets. If the 
machine does not have that much memory available, a RAM upgrade is recommended to achieve 
the best performance. 

On Windows, you can see the free available memory by opening the Windows Task Manager and 
clicking the Performance tab. 

Do you need Administrator privileges on the client machine to modify Java runtime settings? 
It depends on who installed Java on the machine. If the Administrator installed it, only he will have 
permission to modify Java runtime settings. 

What is the -Xmx Java runtime parameter? 
It sets the maximum size of the heap. The default value is 64Mb. 

Are there other Java runtime parameters? 
Yes, there are several other Java runtime parameters that you can configure. For a complete list, 
see the Java Control Panel documentation. 

 

http://java.sun.com/
http://java.sun.com/
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